
 

 
www.dbooks.org

https://www.dbooks.org/


Visual Studio for Mac 

Succinctly 
By 

Alessandro Del Sole 

Foreword by Daniel Jebaraj 

 

 

 

 

 

 

 

 

 

 

 

 



 

3 

Copyright © 2018 by Syncfusion, Inc. 

2501 Aerial Center Parkway 

Suite 200 

Morrisville, NC 27560 

USA 

All rights reserved. 

 

Important licensing information. Please read. 

This book is available for free download from www.syncfusion.com on completion of a 

registration form. 

If you obtained this book from any other source, please register and download a free copy from 

www.syncfusion.com. 

This book is licensed for reading only if obtained from www.syncfusion.com. 

This book is licensed strictly for personal or educational use. 

Redistribution in any form is prohibited. 

The authors and copyright holders provide absolutely no warranty for any information provided. 

The authors and copyright holders shall not be liable for any claim, damages, or any other 

liability arising from, out of, or in connection with the information in this book. 

Please do not use this book if the listed terms are unacceptable. 

Use shall constitute acceptance of the terms listed. 

SYNCFUSION, SUCCINCTLY, DELIVER INNOVATION WITH EASE, ESSENTIAL, and .NET 

ESSENTIALS are the registered trademarks of Syncfusion, Inc. 

 

 

 

Technical Reviewer: James McCaffrey 

Copy Editor: Courtney Wright 

Acquisitions Coordinator: Tres Watkins, content development manager, Syncfusion, Inc. 

Proofreader: Jacqueline Bieringer, content producer, Syncfusion, Inc. 

www.dbooks.org

http://www.syncfusion.com/
http://www.syncfusion.com/
http://www.syncfusion.com/
https://www.dbooks.org/


 

4 

Table of Contents 

The Story Behind the Succinctly Series of Books ................................................................. 9 

About the Author ....................................................................................................................11 

Chapter 1  Introducing Visual Studio for Mac .......................................................................12 

Introducing Visual Studio for Mac .........................................................................................12 

Setting up the development environment..............................................................................14 

Configuring the Mac for mobile app development ............................................................14 

Installing Visual Studio for Mac ........................................................................................15 

Chapter summary .................................................................................................................15 

Chapter 2 Exploring the IDE ...................................................................................................16 

The Welcome page ..............................................................................................................16 

The Get Started area .......................................................................................................17 

The Recent area ..............................................................................................................17 

The Developer News area ...............................................................................................17 

Creating projects ..................................................................................................................17 

Available project types .....................................................................................................18 

Creating your first C# project ...........................................................................................20 

Running projects ..............................................................................................................21 

Understanding pads .............................................................................................................23 

The Classes pad ..............................................................................................................23 

The Errors pad .................................................................................................................24 

The Properties pad ..........................................................................................................25 

The Toolbox pad ..............................................................................................................26 

Working with the code editor ................................................................................................27 

Syntax colorization ...........................................................................................................28 



 

5 

The Edit menu .................................................................................................................28 

Zooming the code editor ..................................................................................................28 

IntelliSense ......................................................................................................................28 

Live static code analysis ..................................................................................................30 

Code refactoring ..............................................................................................................31 

Navigating your code ............................................................................................................33 

Navigating between files ..................................................................................................33 

The scrollbar ....................................................................................................................33 

Minimap mode .................................................................................................................34 

Block delimiter selection ..................................................................................................35 

Find References ..............................................................................................................35 

Navigate ..........................................................................................................................36 

Browsing objects within a code file...................................................................................38 

Folding code blocks .........................................................................................................38 

Generating types on the fly ..............................................................................................38 

Enabling multicursors.......................................................................................................39 

Navigate To .....................................................................................................................40 

Managing dependencies ......................................................................................................41 

Referencing libraries ........................................................................................................41 

The NuGet package manager ..........................................................................................42 

Chapter summary .................................................................................................................45 

Chapter 3  Debugging Applications .......................................................................................46 

Available debuggers .............................................................................................................46 

Setting up an example ..........................................................................................................46 

Reading the output from the debugger .................................................................................47 

Working with breakpoints and data visualizers .....................................................................48 

www.dbooks.org

https://www.dbooks.org/


 

6 

Configuring breakpoints ...................................................................................................50 

Function and exception breakpoints .................................................................................51 

Analyzing runtime errors .......................................................................................................52 

Executing code in steps ........................................................................................................53 

The Debug pads ...................................................................................................................55 

The Breakpoints pad ........................................................................................................55 

The Locals pad ................................................................................................................56 

The Watch pad ................................................................................................................56 

The Call Stack pad ..........................................................................................................57 

The Threads pad .............................................................................................................57 

Chapter summary .................................................................................................................58 

Chapter 4  Creating .NET Core Apps .....................................................................................59 

.NET Core architecture .........................................................................................................59 

The .NET Core runtime ....................................................................................................59 

.NET Core libraries ..........................................................................................................59 

.NET Core SDK: Tools and languages .............................................................................60 

Supported .NET Core project types ......................................................................................60 

Web applications with Visual Studio for Mac ........................................................................61 

Introducing ASP.NET Core ..............................................................................................61 

Introducing MVC ..............................................................................................................62 

Scaffolding an MVC application .......................................................................................62 

Configuring project options ..............................................................................................65 

Running and debugging ...................................................................................................68 

Publishing ASP.NET Core applications ............................................................................69 

Testing with examples .....................................................................................................70 

Chapter summary .................................................................................................................71 



 

7 

Chapter 5  Creating Xamarin Projects ...................................................................................72 

Introducing Xamarin and Xamarin.Forms .............................................................................72 

Available project types ..........................................................................................................72 

Multiplatform project templates ........................................................................................73 

iOS and tvOS project templates .......................................................................................76 

Android project templates ................................................................................................77 

Project templates for macOS ...........................................................................................79 

Creating a Xamarin.Forms project ........................................................................................80 

Xamarin project options ........................................................................................................86 

Hints about publishing apps .................................................................................................90 

Chapter summary .................................................................................................................91 

Chapter 6  Version Control with Git .......................................................................................92 

Preparing a sample repository ..............................................................................................92 

Working with file changes .....................................................................................................93 

Collaborating with other developers ......................................................................................96 

Cloning repositories .........................................................................................................96 

Branching and merging ....................................................................................................97 

Resolving conflicts ......................................................................................................... 100 

Synchronizing branches ................................................................................................. 100 

Hints about stashes ....................................................................................................... 101 

Chapter summary ............................................................................................................... 101 

Chapter 7  Customizing and Extending Visual Studio for Mac .......................................... 102 

Customizing Visual Studio for Mac ..................................................................................... 102 

Applying a theme ........................................................................................................... 102 

Customizing author information ..................................................................................... 103 

Customizing key bindings .............................................................................................. 103 

www.dbooks.org

https://www.dbooks.org/


 

8 

Customizing fonts .......................................................................................................... 104 

Customizing the color of comments ............................................................................... 104 

Custom tools .................................................................................................................. 105 

Introducing custom layouts ............................................................................................ 105 

Extending Visual Studio for Mac ......................................................................................... 106 

Updating Visual Studio for Mac .......................................................................................... 107 

Chapter summary ............................................................................................................... 107 

 

 



 

9 

The Story Behind the Succinctly Series 
of Books 

Daniel Jebaraj, Vice President 
Syncfusion, Inc. 

taying on the cutting edge 

As many of you may know, Syncfusion is a provider of software components for the 
Microsoft platform. This puts us in the exciting but challenging position of always 
being on the cutting edge. 

Whenever platforms or tools are shipping out of Microsoft, which seems to be about every other 
week these days, we have to educate ourselves, quickly. 

Information is plentiful but harder to digest 

In reality, this translates into a lot of book orders, blog searches, and Twitter scans. 

While more information is becoming available on the Internet and more and more books are 
being published, even on topics that are relatively new, one aspect that continues to inhibit us is 
the inability to find concise technology overview books.  

We are usually faced with two options: read several 500+ page books or scour the web for 
relevant blog posts and other articles. Just as everyone else who has a job to do and customers 
to serve, we find this quite frustrating. 

The Succinctly series 

This frustration translated into a deep desire to produce a series of concise technical books that 
would be targeted at developers working on the Microsoft platform.  

We firmly believe, given the background knowledge such developers have, that most topics can 
be translated into books that are between 50 and 100 pages.  

This is exactly what we resolved to accomplish with the Succinctly series. Isn’t everything 
wonderful born out of a deep desire to change things for the better? 

The best authors, the best content 

Each author was carefully chosen from a pool of talented experts who shared our vision. The 
book you now hold in your hands, and the others available in this series, are a result of the 

S 
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authors’ tireless work. You will find original content that is guaranteed to get you up and running 
in about the time it takes to drink a few cups of coffee.  

Free forever  

Syncfusion will be working to produce books on several topics. The books will always be free. 
Any updates we publish will also be free.  

Free? What is the catch? 

There is no catch here. Syncfusion has a vested interest in this effort.  

As a component vendor, our unique claim has always been that we offer deeper and broader 
frameworks than anyone else on the market. Developer education greatly helps us market and 
sell against competing vendors who promise to “enable AJAX support with one click,” or “turn 
the moon to cheese!” 

Let us know what you think 

If you have any topics of interest, thoughts, or feedback, please feel free to send them to us at 
succinctly-series@syncfusion.com.  

We sincerely hope you enjoy reading this book and that it helps you better understand the topic 
of study. Thank you for reading. 

 

 

 

 

 

 

 

 

Please follow us on Twitter and “Like” us on Facebook to help us spread the  
word about the Succinctly series! 

                      

mailto:succinctly-series@syncfusion.com
https://twitter.com/Syncfusion
https://www.facebook.com/Syncfusion
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Chapter 1  Introducing Visual Studio for Mac 

Visual Studio for Mac is the latest addition to the Microsoft Visual Studio family, and it allows 
you to reuse your existing development skills on macOS for cross-platform development. This 
chapter provides an introduction to Visual Studio for Mac, with an overview of the scenarios it 
best fits in and how to configure your Mac for development. 

Introducing Visual Studio for Mac 

In the past, if you wanted to build applications for different operating systems, platforms, or 
devices, you had to use proprietary development tools and native frameworks on each specific 
platform. For example, Microsoft Visual Studio has always been the development environment 
of choice if you want to build Windows and web applications based on the .NET Framework with 
C#, F#, Visual Basic, and C++. If you have a lot of experience with .NET on Windows, you know 
how powerful the .NET technology is, but the limitation is that it runs only on Windows. This 
limitation can be important because it requires you to publish your .NET web apps and services 
only to Windows Server systems, while many companies actually want Linux as the host. 

 Note: With .NET Core, you now have the .NET runtime capable of running on 
multiple operating systems. 

Additionally, developers working on the Apple stack do not have a framework available that 
allows for building web apps and services at all. As another example, building mobile apps for 
Android, iOS, and Windows 10 requires knowledge of native frameworks, development tools 
and languages, such as Java and Google Android Studio for Android, Apple Xcode and Swift or 
Objective-C for iOS, Microsoft Visual Studio and C# (or Visual Basic) for Windows 10. The effort 
needed to publish an app on all the major stores can be huge and might involve hiring several 
specialized developers to reduce the development time (but with higher costs) or waiting for 
current developers to get the skills and experience they need to build apps for different systems. 
This might save some money on one side, but requires much more time—and time is money. 

The list of examples could be longer and involve other technologies, such as cloud platforms 
and containers, but these two are enough to give you an idea of what software development 
was like at a certain point in time. Concurrently, the demand for applications and services that 
are available on multiple platforms has increased in the market. In summary, many companies 
were in a situation in which they needed to be on multiple platforms, but either with limited 
resources or facing a very big effort. 

Microsoft was aware of all the aforementioned problems, and in recent years the company has 
significantly changed its vision and strategy, opening up to other platforms, embracing open 
source, and focusing even more on cloud services. In fact, Microsoft has been making huge 
investments to bring technologies, platforms, developer tools, frameworks, and services to other 
operating systems such as Linux and macOS, and to typically nonMicrosoft audiences by 
focusing on services much more than in the past. Cross-platform development is of primary 
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importance to this strategy and relies on two major technologies (apart from cloud services and 
platforms): 

• .NET Core: A modular, open-source, cross-platform subset of the .NET Framework that 
enables developers to write applications and services that run on Windows, Linux, and 
Mac in C# and F#. 

• Xamarin: A technology that allows developers to write mobile applications that run on 
Android, iOS, and Windows with C# and F#. 

In this vision, there is one important pillar: using .NET languages such as C# and F# to write 
code for any platform. The most important thing is that developers can reuse their .NET skills on 
Linux and macOS, not just Windows. But to make this possible, developers need professional 
tools they can use to create the next generation of applications. Those working on Windows 
have Visual Studio 2017, the most powerful version ever of the premiere development 
environment from Microsoft, which now supports a variety of nonMicrosoft technologies. For 
other systems, Microsoft first released Visual Studio Code (code.visualstudio.com), an open-
source, cross-platform tool that puts evolved coding at its center. However, Visual Studio Code 
has no built-in designer tools, has no support for Xamarin (at least currently), and does not 
provide specialized tools that developers might need, such as integrated publishing tools or 
profiling instruments. After all, its focus is providing an evolved editing experience. 

True to its history of delivering the best developer tools in the world, and because you need a 
Mac to build, sign, and distribute apps for iOS and macOS, in 2017 Microsoft finally released the 
first version of Visual Studio for Mac. Visual Studio for Mac is an integrated development 
environment that can be used on macOS to build apps that run on any platform and any device 
in C# and F#, and that perfectly fits into this mobile-first, cloud-first vision. Visual Studio for Mac 
is neither a simple porting of Visual Studio on Windows, nor it is an evolution of Visual Studio 
Code. Instead, it is a professional development environment specifically built for the Mac, with a 
native user interface and tools tailored for macOS and for cross-platform development. 

This book provides a guide to Visual Studio for Mac, paying particular attention to the Integrated 
Development Environment, the workspace, and all the integrated tools you can leverage to build 
high-quality, professional applications for mobile devices and the web, using C# as the 
programming language of choice. A basic knowledge of C# is strongly recommended to get the 
most out of the book. You will also find an introduction to building apps with Xamarin and .NET 
Core, so that you will have the necessary foundations to get started. Then you will be able to 
dive deep into both technologies autonomously. 

 Note: With Visual Studio for Mac, you can also develop games based on Unity 
(Unity3d.com). Game development with Unity will not be covered in this book, but it is 
worth mentioning that Visual Studio for Mac already includes the tools for Unity out 
of the box, and you only have to install the Unity engine separately. 

Visual Studio for Mac is available in three different editions: Community, Professional, and 
Enterprise. If you do not have an MSDN subscription and you are an individual developer, you 
can install the Community edition for free. This edition can also be used under strict licensing 
terms in both enterprise and non-enterprise organizations. Microsoft has a specific page that 
describes the license for Visual Studio for Mac Community. 

www.dbooks.org
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Unless otherwise specified, all the topics described in this book are available in all three 
editions. System requirements: you will need a Mac with at least 4 GB RAM, a 1.8 GHz 
processor, and 1 GB of disk space. El Capitan 10.11 is the minimum version of macOS that 
supports Visual Studio for Mac. Of course, the recommended configuration is with macOS 
Sierra 10.12 and with 8 GB RAM. After this short introduction, it is time to get started. But before 
you can put your hands on Visual Studio for Mac, you need to set up and configure your Mac 
machine for development. 

 Note: I will refer to the product as Visual Studio for Mac, Visual Studio, and VS for 
Mac interchangeably. 

Setting up the development environment 

In order to build applications with Visual Studio for Mac, you need to configure your Mac 
machine for development. Actually, you only need to install Visual Studio for Mac if you plan to 
work with .NET Core. If you, instead, plan to work with Xamarin for mobile app development 
also, you will need a few more components, as described in the next paragraphs. 

Configuring the Mac for mobile app development 

Among others, with Visual Studio for Mac, you can build mobile apps using Xamarin. To 
accomplish this, you first need to further configure the Mac. In fact, you must install Xcode 10, 
the Apple IDE, and Apple SDKs, which you get from the App Store for free. The download is 
approximately 5 GB, so it will take some time to get it ready. 

The reason you need Xcode is simple: Apple’s policies establish that only Xcode can generate 
and sign iOS app packages; therefore, tools such as Visual Studio for Mac will need to invoke 
Xcode and the Apple SDKs behind the scenes to generate and sign your app binaries. When 
Xcode has been installed, you should at least create and run a new blank project, so that Xcode 
will generate all the necessary files for development. The official Xamarin documentation has a 
specific page that will help you configure a Mac computer; I recommend you read it carefully, 
especially because it explains how to configure profiles and certificates and how to use Xcode 
to perform preliminary configurations. 

 Note: If you want to sign and publish your apps to the Apple Store and Google 
Play, you will need paid developer accounts. These are not required in this book 
because Android does not require any account for development purposes, and Apple 
offers a free account. 

https://developer.xamarin.com/guides/ios/getting_started/installation/windows/connecting-to-mac/
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Installing Visual Studio for Mac 

Once you have downloaded the Visual Studio for Mac installer from the Microsoft website or 
from your MSDN subscription portal, simply double-click the .dmg (disk image) file. When the 
installer starts, you will only need to specify which components you want to install. I recommend 
you select all the available .NET Core and Xamarin components in order to fully set up your 
development environment and to be able to follow all the examples provided in the next 
chapters. 

Chapter summary 

Visual Studio for Mac is a powerful development environment Microsoft built for macOS that 
allows for cross-platform development using C# and F# to create .NET Core and Xamarin 
projects. Installing Visual Studio for Mac, also offered for free via the Community edition, is the 
only requirement to build .NET Core apps, whereas the Apple SDKs and Xcode are also 
required to build apps with Xamarin. 

Now that the development machine is ready, it’s time to get started with the Visual Studio for 
Mac environment and its user interface, expressly designed for macOS. 

www.dbooks.org
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Chapter 2 Exploring the IDE 

Visual Studio for Mac provides a very powerful Integrated Development Environment (IDE) with 
a very versatile code editor and tons of productivity tools. This chapter provides guidance on 
how you can leverage the integrated tools and get the most out of the IDE in terms of 
productivity. 

The Welcome page 

At startup, Visual Studio for Mac shows the Welcome page. This contains a number of shortcuts 
and links that simplify common tasks. Figure 1 shows how it appears. 

 

Figure 1: The Welcome page 

You can open the Welcome page at any time by selecting Window > Welcome Page. This 
page is made of several areas, all described in the next paragraphs. 
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The Get Started area 

On the left side of the Welcome page, you find the Get Started area. Here, you find links to 
official online resources that you can read to get further information about Visual Studio for Mac, 
.NET Core, and Xamarin. 

The Recent area 

The Recent area displays the list of most recently used projects and is located to the right of the 
Get Started area. If this is the first time you’ve opened Visual Studio, the Recent area will be 
empty. In Figure 1, you can see an example of a list of most recently used projects as it appears 
on my machine. 

Simply click on a project name to open it. You can also filter the list by typing inside the Filter 
text box. When you hover over a project name, you will also see an icon with the x symbol, 
which allows you to remove projects from the list. Notice that this action does not delete the 
project from disk; it just removes the project from the list of most recently used ones. 

The Developer News area 

The Developer News area is located at the right side of the Welcome page, and aggregates 
news and updates from the Visual Studio team’s blog and other Microsoft resources. Simply 
click a hyperlink to open your web browser and read the full article or blog post online. This is a 
very convenient way to receive updates from Microsoft official sources and learn about new 
features and releases in Visual Studio for Mac. 

Reporting feedback 

At the top of the Developer News area, you will also see two shortcuts called Report a Problem 
and Provide a Suggestion. The first shortcut allows you to report any problems found in Visual 
Studio directly to Microsoft. Visual Studio shows a dialog where you can enter detailed 
information and optionally add screenshots. The second shortcut, Provide a Suggestion, will 
open the User Voice website in your browser. User Voice is the place where users can send 
their suggestions or feature requests for a particular Microsoft product. 

Creating projects 

You create projects via the New Project button on the Welcome page, or by selecting File > 
New Solution. Both actions open the New Project dialog, where you can see the full list of 
available project templates. Figure 2 shows an excerpt of the full list, which you can see by 
scrolling the list on the left side of the dialog. 

www.dbooks.org
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Figure 2: Creating a new project 

In the next subsection, you will read more details about the available project templates, then in 
Chapters 3 and 4 you will learn how to use a few templates for .NET Core and Xamarin. 
Remember that you can simply click a project template to see a description on the right side of 
the dialog. For example, in Figure 2 you can see a description of the ASP.NET Core Web App 
project template. In this case, the description explains how this project template generates a 
solution made of an ASP.NET Core application that includes sample ASP.NET Razor Pages. 
You will get a similar description when clicking on the other project templates. 

 Tip: You must scroll the list on the left in order to see all available project 
templates. Also, the New Project dialog presents a tab called Recently used, where 
you will see a list of the most recently used project templates. 

Available project types 

Visual Studio for Mac allows for building a variety of different applications, from web (.NET 
Core) to mobile (Xamarin) to cloud (Azure). Additionally, it also allows building apps for .NET 
using Mono as the development platform. Table 1 summarizes the available project categories 
in Visual Studio for Mac. 
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Table 1 

Available project categories 

Category Description 

Multiplatform Contains Xamarin project templates that 
focus on code reuse to build cross-
platform apps, games, and libraries. 

iOS Contains project templates based on 
Xamarin.iOS that allow you to build apps, 
games, and libraries for the iPhone and 
iPad. 

tvOS Contains project templates based on 
Xamarin.TVOS that allow you to build 
apps, games, and libraries for the Apple 
tvOS. 

Android Contains project templates based on 
Xamarin.Android that allow you to build 
apps, games, and libraries for Android 
devices, including wearable devices. 

.NET Core Contains project templates that allow you 
to build cross-platform Console and web 
applications based on .NET Core. 

Mac Contains project templates based on 
Xamarin.Mac that allow you to build 
applications and games for macOS. 

Cloud Contains project templates that allow for 
developing Azure Functions in C#. 

Other Contains miscellaneous project templates; 
most relevant templates allow the building 
of Console and ASP.NET web apps and 
services that run on Mono. 

Each category is made of one or more specialized project templates. All the project categories 
consist of three subcategories: App, Library, and Tests. The App subcategory includes project 
templates you use for app development; Library contains project templates you can use to 
author libraries, both universal libraries with the .NET Standard specification and platform-
specific libraries; and Tests includes project templates you can use to write unit tests (.NET 
Core) and automated UI tests (Xamarin). As an exception, the Cloud category consists only of a 
subcategory called General. 

 Note: Project templates for game development with Unity will be available in the 
New Project dialog once you install the proper tools. 

www.dbooks.org
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Creating your first C# project 

In order to discover the goodies of the Visual Studio for Mac IDE, you need to create at least a 
basic project. In the New Project dialog, select the Console Application template under .NET 
Core (see Figure 2), then click Next. On the next screen, select the highest version of .NET 
Core available on your machine, then click Next. On the final screen (see Figure 3), enter a 
name of your choice for the new sample app. 

 

Figure 3: Entering a project name 

The Location text box allows you to specify a folder for your new solution. By default, Visual 
Studio for Mac creates a Projects folder under the Home directory of your Mac. You can click 
Browse to select a different folder, or you can simply type a new folder name, and you can also 
change the default folder in the IDE options. I recommend that you leave the check box selected 
next to “Create a project directory within the solution directory.” This option ensures that a root 
folder is created for the solution and that a subfolder in the solution folder is created for the new 
project. This helps to keep the solution’s structure well organized, especially if you plan to add 
new or existing projects to the solution later. 

The New Project dialog provides a visual representation of the solution’s folder structure on the 
right side, under Preview. You will see how this preview changes depending on whether the 
directory check box is selected or deselected. You also have an option to enable Git version 
control for the solution, but this will be discussed in more detail in Chapter 5. 

When you’re ready, click Create. After a few seconds, your new project will be ready. If you’ve 
never made customizations to the IDE, by default, you will see the Solution pad on the left side 
of the workspace and the code editor on the right side. You might also see additional pads, such 
as Errors. If you do not see the code editor, expand the project view in the Solution pad and 
double-click the Program.cs file. At this point, your workspace should look like Figure 4. 
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Figure 4: A new C# Console application project-ready 

When you create a new project or open an existing solution, Visual Studio for Mac will 
automatically attempt to refresh any references to external libraries, such as NuGet packages. 
This might take a few seconds; you will see the progress of the restore operation in the upper 
status bar (where you can normally see the Visual Studio icon and product name). This is 
important to remember, because you might have projects that have dependencies, and you 
might see some error squiggles in the code editor until libraries restoration is completed. 

The Solution pad (which you can see on the left in Figure 4) is a very important tool, and you will 
work with it all the time. It basically provides a hierarchical view of your solution and allows you 
to browse for files and folders. You can also right-click the solution name and then select Add > 
New Project or Add > Existing Project to add new or existing projects. You can also add 
individual files and folders (referred to as solution items) that will not be part of the build output, 
but that you might need for several purposes, such as documents or images you might want to 
include for your team. 

For each project in the solution, the Solution pad shows not only files but also dependencies 
your project has on specific SDKs (such as .NET Core in the current example) or on external 
libraries. Notice how the code editor provides syntax colorization for any of the supported 
languages, as you might certainly expect. 

Running projects 

As a common behavior, Visual Studio for Mac provides commands to compile your code in the 
Build menu via the Build All, Rebuild All, Build, and Rebuild commands. When you compile 
your code, you also need to select a build configuration, and Visual Studio for Mac exposes the 
Debug and Release configurations, which are self-explanatory, especially if you have 
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experience with Visual Studio for PC. You can select the configuration from the standard toolbar 
(see Figure 5). 

 

Figure 5: The standard toolbar 

Notice that additional configurations might be available, depending on platform-specific project 
templates, but these two are certainly available to all projects. You can run your solutions with 
the Start button in the toolbar and with two commands from the Run menu: Start Debugging 
and Start Without Debugging. In the first case, you first select the Debug configuration, and 
then you invoke the command. This will launch the application from within the IDE with an 
instance of the debugger attached and will enable the powerful debugging tools in Visual Studio 
that you will learn to leverage shortly. In the second case, you can select the Release 
configuration, and the application will start without an instance of the debugger, detached from 
the IDE. You can certainly leave the Debug configuration selected when running the application 
without debugging, but the generated debug symbols will be ignored. 

Once you have selected the configuration, you can start the application and, apart from the two 
commands in the Run menu, the easiest way by is clicking the Start button, which you can see 
in Figure 5. When you start the application, Visual Studio first saves all recent changes, and 
then it performs a Build All operation if it detects some changes from the last build (or if you 
have never built the solution). It does not perform a Build All operation if you already called Build 
All or Rebuild All before starting the application. Figure 6 shows the sample Console application 
running in the Terminal. 

 

Figure 6: The sample app running in the Terminal 
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In this case, the application has been started with the Debug configuration enabled, so an 
instance of the debugger is attached. All the steps you have seen so far apply to all the 
supported project types, and the only difference will be the application host, which can be a 
Terminal window, a web server, a device simulator, or a physical device, depending on the 
project type. 

Understanding pads 

Pads are floating tool windows that are responsible for various tasks. Pads in Visual Studio for 
Mac can be compared to tool windows in Visual Studio on Windows, and to pads in Apple’s 
Xcode. Pads can be docked and arranged in the workspace according to your preferences, so 
that you can customize the development environment in the best way for you. 

In the previous sections, you worked with the Solution pad, which allows you to browse and 
manage projects and code files in a solution. In this section, you will learn about the other most 
important and common pads in Visual Studio for Mac. Some other specific pads will be 
discussed where appropriate. 

As a general rule, pads can be enabled with View > Pads. When you open a pad, it is 
automatically docked and positioned in a specific place in the IDE, but you can rearrange it as 
you like, and you can also undock a pad and treat it as a standalone window. 

You can also auto-hide pads to show them only when necessary and maximize the editor area 
by simply clicking their labels. In order to undock a pad, you click its title and move it by keeping 
the left mouse button pressed and dragging, and then you release it when you see that its 
height is not constrained into other areas of the workspace. In the undocked state, a pad works 
like a stand-alone window; therefore, it has the classic three buttons to close, minimize, and 
maximize it. You can dock a floating pad by simply clicking the Dock button on its toolbar. 
Visual Studio will automatically dock the pad in the position it was docked previously. In the 
docked state, the Dock button changes into Auto-Hide, which you can click to completely hide 
the pad except for its label, which you can click to open the pad. Then it will be auto-hidden 
again once you click outside of it. 

In Figure 4, you can see a number of pads in a hidden state with only their labels visible, such 
as Classes, Toolbox, Properties, Document Outline, and Unit Tests, and also the Errors 
pad in the foreground. You can also completely close a pad by clicking the Close button on its 
toolbar, but then you will need to select View > Pads to open it again. In order to rearrange 
pads in the workspace, you click a pad’s title and move it to the desired position. An explanation 
of the available pads will be provided in the next paragraphs. 

The Classes pad 

The Classes pad provides a hierarchical view of all the types and their members defined within 
projects in a solution. Figure 7 provides an example based on a namespace that contains 
several classes, an interface, and an enumeration. 
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Figure 7: The Classes pad 

 

As you can see, classes show all the types defined inside a namespace and can be expanded 
to show the members they define. Namespaces are represented by gray icons and an open 
bracket. Value types are represented by a green icon and the first letter of the type (E for 
enumerations and S for structures). Reference types are represented by light blue icons and the 
first letter of the type (C for classes, I for interfaces, and D for delegates). Type members are 
represented by a violet icon for fields and properties, by a light blue icon for methods, by a red 
icon for constants, plus the first letter of the member type (F for fields, P for properties, M for 
methods, and C for constants).  

Notice that, in the case of C# auto-implemented properties, the Classes pad also shows the 
implicit, private backing fields that the compiler generates behind the scenes. Icons also help 
with understanding a type or member’s visibility: if a type or member is public, the icon has no 
border; if it is private, the icon has a strong border; if it is protected, the icon has a thin border; if 
it is internal, the icon has thin borders only around its corners. Notice how, for static members, 
an overlay icon representing four black squares is added to the object icon. If you double-click a 
type or member in the Classes pad, the code editor will immediately move the cursor to that 
type or member, and it will also highlight all the occurrences of its name in the code file. The 
Classes pad is extremely useful as a visual representation of the hierarchy of objects in your 
solutions and is a perfect companion for the Solution pad. 

The Errors pad 

The Errors pad shows all the messages that Visual Studio for Mac generates during the 
development of an application. Messages can be errors, warnings, and messages. Errors 
include any problems or blocking errors the compiler encounters that prevent your code from 
being successfully compiled and, consequently, prevent your application from running. 
Warnings include messages about potential problems that actually do not prevent your code 
from being compiled successfully, but that should not be ignored. The compiler also reports 
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warnings that help you keep your code clean, for example, with unused declared variables. 
Messages are just informational messages that have no impact on the build process. Figure 8 
shows an example of the Errors pad displaying information about an error. 

 

Figure 8: The Errors pad 

For each error, warning, or message, the Errors pad shows the line number in the code file 
(Line column), the error description (Description column), the code file where the problem was 
detected (File column), the project name (Project column), and the path (Path column). 
Optionally, the Errors pad might show a category based on the .NET coding rules. Messages 
can be filtered to exclude errors, warnings, and messages by simply clicking the corresponding 
button or by typing key words in the search box. If you double-click a message, the code editor 
will move the cursor to the code file and line number where the problem was detected. 
Additionally, you can right-click a message and select Show Error Reference to find 
information about the error code on the Internet.  

The Errors pad is not the only way for Visual Studio to report errors and warnings. In fact, the 
code editor also plays a key role in this by underlining errors and warnings with the so-called 
squiggles, wavy lines that appear under code issues and that are red for errors and green for 
warnings.  

The Properties pad 

Because you often need to set properties for your .NET objects, layouts, and files, Visual Studio 
for Mac provides a convenient tool to set properties for files and objects, called the Properties 
pad. The appearance of the Properties pad is different according to the item you need to set 
properties for, but it generally appears as a two-column table in which the left column displays 
the property name and the right column shows or sets the property value. Figure 9 shows an 
example of the Properties pad for a C# code file. 
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Figure 9: The Properties pad 

You will use the Properties pad often, so additional explanations will be provided where 
appropriate. The Properties pad is particularly useful when working with user interface elements 
in web or Xamarin projects, because it allows you to set object properties with a visual tool 
instead of setting all the properties manually in the code. 

The Toolbox pad 

The Toolbox pad makes it easy to add items to your code or to elements of the user interface. 
Instead of manually writing code snippets or writing the code that defines a piece of user 
interface at design time, you can drag items from the Toolbox pad onto the code editor or the 
designer surface. Figure 10 shows an example of the Toolbox as it is available over a C# code 
file, presenting a list of available code snippets.  
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Figure 10: The Toolbox pad  

In this case, the Toolbox pad contains a list of code snippets that you can drag onto the code 
editor to insert a ready-to-use code block.  

Working with the code editor 

The code editor in Visual Studio for Mac is the place where you will spend the most time in your 
developer life, and therefore it deserves a thorough explanation. In this section, you will learn 
how to get the most out of the features that empower the code editor to boost your productivity, 
and you will see how most of the tools work directly in the active editor window, so that you will 
never lose the focus on your code.  

As a general rule, Visual Studio will open a new editor window every time you double-click a 
code file in the Solution pad. Each code file lives in a separate editor window that is represented 
by a tab. Visual Studio can handle infinite editor windows (and tabs). By default, the code editor 
shows the full view of a code file, but you can split a single editor window into two columns with 
View > Editor Columns > Two Columns. This is useful when you need to work on different 
places in the same code file concurrently. Use View > Editor Columns > One Column to 
restore the original view. 
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Syntax colorization 

As you would expect, Visual Studio for Mac’s code editor provides syntax colorization for all of 
the supported languages, such as C#, F#, XML, XAML, HTML, JavaScript, JSON, and Visual 
Basic. In all other cases, the code editor will treat files as plain text documents.  

The Edit menu 

The Edit menu offers common commands for editing source text, such as Copy, Paste, Cut, 
Undo, Redo, and Select All. It also provides the Format submenu, which includes commands 
to fix spaces such as Format Document, Indent, and Unindent. You can also quickly convert 
a line, string, or identifier to uppercase and lowercase with the same-named commands. With 
Join Lines, you can make a number of selected lines of code into a single line. With Toggle 
Line Comments, you can quickly comment or uncomment one or more lines. For each 
command, the Edit menu also shows the proper keyboard shortcuts. The most common are 
Command + C (Copy), Command + V (Paste), Command + X (Cut), and Command + Z (Undo).  

Zooming the code editor 

You can zoom the content of the active editor by pressing Option and then moving the mouse 
wheel up (zoom out) or down (zoom in). 

IntelliSense 

IntelliSense has always been one of the biggest points of strength in Microsoft Visual Studio on 
Windows, and now this technology is also available in VS for Mac. IntelliSense is an advanced 
word-completion engine that provides suggestions based on context and offers help and tips on 
how to use a type or member. IntelliSense shows up when you start typing in the code editor. 
Figure 11 shows an example in which the developer starts writing a type name. 



 

29 

 

Figure 11: IntelliSense’s keyword completion  

IntelliSense automatically filters the list of available words for completion as you type. When you 
scroll the list and select an item, a tooltip appears and shows documentation about that item. 
You can press the spacebar or Tab to insert the selected word. Notice how items in the list have 
the same icons with the same colors you saw previously with the Classes pad. It is worth 
mentioning that IntelliSense here is showing only what it thinks is suitable in the current context, 
so it does not show reserved words or other objects that should not be in a method body. If you 
insert a word and then press the dot, IntelliSense will show objects available for the inserted 
item. When you scroll the list of members, you will see a tooltip with the member signature and 
the documentation. In the case of methods, if you press the left and right cursor keys, you will 
be able to scroll the list of method overloads. Additionally, when you insert methods, 
IntelliSense will show contextualized documentation for method parameters when you open the 
left parenthesis. 

 Tip: Another demonstration of how IntelliSense provides contextualized 
suggestions is outside of namespace declarations: in this case, only a few reserved 
words are supported, and thus IntelliSense properly suggests only the words that the 
compiler accepts to be outside a namespace declaration, such as the using, 
unchecked, and namespace reserved words. 

IntelliSense also makes it easier to insert ready-to-use code snippets via the so-called 
templates. When you encounter the (…) icon in the word completion list, you can press Tab to 
insert a code snippet for the given template. For instance, you can select the (…) interface item 
to quickly insert an interface stub. The code editor will then highlight all the auto-generated 
identifiers that you might want to rename or that need your attention. 
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Live static code analysis 

The code editor leverages the .NET Compiler Platform (also known as project “Roslyn”) to 
detect code issues as you type and provide quick fixes and suggestions with all the supported 
languages. When code issues are detected, the code editor underlines the code that has issues 
with red squiggles for errors, and with green squiggles for warnings. The code editor places an 
in-line message that contains the error description near the code issue. Figure 12 shows an 
example based on a class that should implement the IDisposable interface, but that actually 

does not. 

 

Figure 12: Live code issues detection  

 Tip: While squiggles are immediately visible, in-line messages might not be. In this 
case, build the project so that the code editor will be refreshed with in-line messages 
along with the Errors pad. 

With most errors and warnings raised by the compiler, Visual Studio is also able to offer a 
proper fix. For example, if you right-click a code issue and then select Quick Fix, the code 
editor will offer one or more possible code fixes for that context, with a live preview of how the 
code will look like after the fix. In the current example, the code editor offers four different 
alternatives to implement the IDisposable interface, with a live preview for each (see Figure 

13). As an alternative, you can click the word that is underlined with a squiggle and wait for a 
little overlay line that appears over the word, which you can click to enable the quick fix actions.   

https://github.com/dotnet/roslyn
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Figure 13: The code editor suggests quick fixes for the current context  

You can select one of the suggested fixes and the code editor will implement the code based on 
your selection. Listing and describing all the available code fixes for all the errors and warnings 
the compiler can detect is not possible here, but just keep in mind that fixes are available for 
code issues that occur when using the C# language and libraries from Microsoft. Live analysis 
and code fixes dramatically improve your coding experience, as they provide a convenient way 
to fix code issues within the active editor window, helping you keep your focus on the code. 

 Tip: You can see the list of available analysis rules and quick fix actions in the 
Visual Studio preferences. To accomplish this, select Visual Studio > Preferences > 
Text Editor > Source Analysis > C#. The dialog will be divided into two tabs: one 
containing the list of code issues, and one containing the list of actions. You can also 
disable and enable both via the corresponding check boxes. 

Code refactoring 

Refactoring is the process of rewriting a piece of code in a better way, without changing its 
original behavior. By leveraging the C# compiler’s APIs, the code editor in Visual Studio for Mac 
offers a large number of built-in code refactorings. As a general rule, you can select a piece of 
code, right-click, and then select either Refactor or Quick Fix to see if a code refactoring is 
available. Additionally, Visual Studio automatically detects the availability of a code refactoring 
for a specific code block, so it underlines a keyword or block with an overlay icon that you can 
recognize by three small dots, which you can click to discover potential refactorings. Keep these 
options in mind, because only the most common refactorings will be discussed here. You can 
select a single identifier or type name, a line of code, or even a code block, as refactorings are 
available at different levels.  

Common built-in refactorings include the following: 
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Removing redundant code: Names of unused variables or namespaces are colored in gray 
instead of black, or keywords refering to redundant code are colored in light blue. When you see 
redundant code, you can hover over it with the mouse, and the code editor will show a 
descriptive tooltip of the full message. Then you can right-click the redundant code, select 
Quick Fix, and choose the proper fix. 

Extracting code blocks: You can create a method from a set of lines of code inside another 
method. To accomplish this, select the code block you want to extract, right-click, and select 
Quick Fix > Extract Method. Once the method has been created, you will be provided with an 
option to enter a new method name. Another useful refactoring allows extracting of an interface 
from a class. To accomplish this, right-click a class name and select Quick Fix > Extract 
Interface. 

Renaming identifiers: The code editor allows you to easily rename identifiers directly inline, 
without modal dialogs. For example, you can right-click a variable name, then select Refactor > 
Rename. At this point, the identifier will be highlighted. Just type the new name, and you will 
see how all the occurrences of the identifier will be renamed as you type. Also, the code editor 
highlights the line numbers for lines where an occurrence of the identifier is being renamed. 

Changing access modifiers: Access modifiers represent the visibility of types and members, 
and are represented by the public, private, internal, protected, and protected 

internal keywords. Most code blocks share refactorings that allow you to quickly change the 

access modifier, such as To public and To private. 

Changing method definitions: The C# compiler provides some interesting code refactorings 
for methods and method parameters. Table 2 provides a quick summary. 

Table 2 

Method refactoring 

Name Scope Description 

Change signature Method Allows you to quickly 
change the signature 
of a method. 

To… Method Allows you to quickly 
change the access 
modifier of a method. 

Create Overload Without 
parameter 

Method Offers to create a 
method overload 
without parameters, if 
one does not already 
exist. 

Add null check for parameter Parameter Introduces a code 
snippet that checks if a 
parameter value is null 
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Method refactoring 

(only with reference 
types). 

Add contract requiring 
parameter must not be null 

Parameter Introduces a code 
snippet based on the 
Code Contracts library 
that ensures the 
parameter value is not 
null. 

Don’t forget to right-click an object in the code editor and then select either Quick Fix or 
Refactor to see what other code refactorings are available. 

Navigating your code 

Visual Studio for Mac offers a number of features that allow you to browse your source code 
quickly and easily move among files, types, and members. This section explains these features 
and how to increase your productivity in the editing experience. 

Navigating between files 

Instead of moving to a different file using the Solution pad, you can press Control + Tab. Visual 
Studio will show a pop-up containing the list of files that can be opened with an editor window. 
You can simply keep Control pressed and go on pressing Tab to select a different file. Just 
release both keys when you have made your choice. As an alternative, you can open the 
Window menu and select the file you want to open in the editor or select Window > Next 
Document and Window > Previous Document to quickly move through the sequence of open 
files. 

The scrollbar 

The editor’s scrollbar does not simply allow you to quickly move inside a source code file; it is 
an advanced tool that gives you a visual, immediate representation of any relevant information 
in the code. For a better understanding, consider Figure 14, where you can see a C# code file 
that contains two intentional errors (a missing semicolon at line 9 and a missing closing bracket 
at line 24), and warnings on the args parameter of the Main method, which is never used and is 

considered redundant.  
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Figure 14: The scrollbar highlights code issues  

As you can see, the scrollbar shows a number of symbols that make it easier for you to 
understand where errors, warnings, comments, and the cursor are. Generally speaking, you can 
hover over a symbol and see a tooltip that describes the related message, and then you can 
click the symbol and the code editor will move the cursor to the line that is affected by the 
information. More specifically, errors are represented with a red line, whereas warnings are 
represented with a yellow line. If the code contains any errors or warnings, the scrollbar will 
show a small colored circle at the top. This circle will be yellow if the code contains only 
warnings, or red if it contains at least one error. You can hover over the circle to see a detailed 
message, and you can click it to quickly go to the next error or warning. 

Minimap mode 

You can right-click the scrollbar and select Show Minimap to enable a small code preview on 
the scrollbar, as shown in Figure 15. You can scroll the map or click on the code map to quickly 
move to a different portion in your code file. You can disable Minimap mode by right-clicking the 
scrollbar and then selecting Show tasks. 
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Figure 15: The Minimap mode of the scrollbar  

The code map is very useful with long code files and continues to show icons and glyphs on its 
right side. 

Block delimiter selection 

With complex, long, and nested code snippets, it might be difficult to understand the enclosing 
blocks. When you click the opening or closing tag for a given code block, VS for Mac 
automatically highlights both enclosing tags, such as brackets or parentheses. 

Find References 

Find References is a tool that allows you to quickly see how many times and where an object 
has been used across the entire solution. To use this tool, right-click the name of an object and 
select Find References. Figure 16 shows an example based on finding all the references for a 
property called Name in a class called Animal. 
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Figure 16: Finding references of types and members  

The list of references appears in the Search Results pad. At the bottom of the pad you see the 
number of results. The Project column shows the name of the project in which the reference 
was found. The File column contains both the name and the line of the code file in which the 
reference was found. The Text column is very useful, because it shows a preview of the code 
that contains the reference with syntax colorization. The Path column shows the folder path for 
the code file. You can double-click a reference to move to the related code in the editor, and 
Visual Studio will open a new editor window on the file if it is not the same as the active editor 
window. The reference will be automatically highlighted in the code. 

Navigate  

The Navigate tool works similarly to Find References, but it provides more advanced capabilities 
for specific scenarios. Navigate can be enabled by right-clicking an item in your code, and then 
selecting Navigate. The submenu offers the navigation commands summarized in Table 3, and 
whose results are shown in the Search Results pad as it was for Find References. 

Table 3 

Options for the Navigate tool 

Name Description 

Find References of All Overloads Finds all references of all the overloads of 
a method that have been used in the 
solution. 

Base Symbols Shows the list of base types and interfaces 
that the type on which you invoked 
Navigate inherits from or implements. If 
you invoked Navigate on a method, it 
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Options for the Navigate tool 

shows the list of methods that the current 
one is overriding. 

Derived Symbols Shows the list of types that inherit from the 
type on which you invoked Navigate. If you 
invoked Navigate on a method, it shows 
the list of methods that are overriding the 
current one. 

Extension Methods Shows the list of extension methods used 
by the object on which you invoked 
Navigate. 

Member Overloads Shows the list of overload definitions for 
the type member on which you invoked 
Navigate. 

Implementing Members Shows the list of types or members that 
are implementing an abstract type or 
member or an interface or its members. 

For example, if you had a class Cat that inherits from Animal and then you wanted to see the 

list of types that derive from Animal, you could right-click the Animal type name, then select 

Navigate > Derived Symbols. This would produce the result shown in Figure 17. 

 

Figure 17: Finding the list of derived symbols 
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Browsing objects within a code file 

Visual Studio for Mac provides a visual way to quickly browse types and members within a code 
file. Each code editor window has tabs that you can click to show the list of types defined in the 
active code file. When you select a type, then you will be able to see the list of its members. 
Figure 18 shows an example. If you click a member name, then the code editor will move the 
cursor to that member’s definition. 

 

Figure 18: Browsing types and members within a code file 

Folding code blocks 

Code blocks can be collapsed by clicking the – symbol near the border of the code editor, and 
they can be expanded by clicking +. Collapsing and expanding code blocks in Visual Studio is 
called folding. The View menu offers a Folding submenu with the following commands: 

• Disable Folding: With this command, code blocks can no longer be folded. You can then 
select Enable Folding to re-enable this feature. 

• Toggle Fold: With this command, you can collapse or expand an individual code block. 
• Toggle All Folds: With this command, you can collapse or expand all the code blocks in 

your code file. 
• Toggle Definition: This command is useful to fold all the code blocks that are nested 

inside a type or member definition. 

Folding code blocks can be useful when you have long files and you need to focus only on a 
specific part of the code. 

Generating types on the fly 

As a developer, you will often realize that you need to create new types while coding. Visual 
Studio for Mac makes it easier to generate new types on the fly with a special kind of code 
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refactoring. For example, suppose you declare a new variable of type Dog, but this type does 

not yet exist in your solution: 

Dog dog1 = new Dog(); 

As you would expect, the editor underlines the type with a red squiggle and reports an error 
saying that it could not find the type. Now, if you right-click the type name and select Quick Fix, 
you will see a number of options that allow you to generate the new type, as shown in Figure 
19. 

 

Figure 19: Generating new types on the fly 

The following options are available: 

• Generate class in new file: Creates a new code file whose name is based on the type 
name and adds an empty class definition with the internal access modifier. 

• Generate class: Generates a new class inside the active code file with the internal 
access modifier. 

• Generate nested class: Generates a new class, nested in the current type, with the 
private access modifier. 

• Generate new type: Shows a dialog that allows you to customize the type generation by 
specifying which type you want to create (class, interface, or enumeration), the access 
modifier, and the destination. 

This quick fix is very useful and allows you to keep your focus on the code while writing. 

Enabling multicursors 

You can enable multiple cursors by pressing and holding Command + Option + the left mouse 
button, and then dragging the pointer over an area or multiple lines. To understand how this can 
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be useful, think of a class that exposes a number of internal properties that you want to change 
to public in batch. You can press Command + Option + the left mouse button and select all the 
internal keywords only. Then you can start typing public, and the original text will be replaced 
on all the selected lines. 

 Navigate To 

Sometimes you need to invoke a tool or command in Visual Studio, but you do not remember 
the exact name, or you do not remember from which menu it can be invoked. In other situations, 
you might have a solution with thousands of files and you do not exactly remember where a file 
you need is. 

Visual Studio for Mac makes your life easier by providing a search box called Navigate To, 
located at the upper-right corner of the IDE, where you can type the name, or just part of it, of 
the tool or file you need. Visual Studio will show a contextual list of matching results, as shown 
in Figure 20. If you come from Visual Studio on Windows, this is the counterpart of the Quick 
Launch tool. 

 

Figure 20: Finding tools and commands with Navigate To 

The list is filtered as you type and shows names of types, code files, and commands that match 
the search criterion. If you click Search Packages, Visual Studio will open the Add Package 
dialog and search for any NuGet packages that match your search criterion. You can also click 
the arrow near the magnifier icon in the search box to filter search results by file, type, and 
member. 
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Managing dependencies 

Any application needs core runtime platforms or libraries to work—these are known as 
dependencies. For example, the .NET Core SDK is a dependency for any .NET Core 
application. The Mono runtime is instead a dependency for any Xamarin project. Visual Studio 
for Mac takes care of adding the proper references based on the type of project you create. 

More often than not, your applications will need to use third-party libraries, or libraries you 
developed, that expose APIs and objects that the core libraries do not provide out of the box. 
When this happens, you are introducing additional dependencies. In VS for Mac, you have two 
main ways to add and consume dependencies in your applications: adding references to 
libraries on disk, and downloading NuGet packages. This section walks through both scenarios. 

Referencing libraries 

If you need to consume a library that is on disk, either third party or developed by you, in the 
Solution pad you can add a reference to the library. The way you add a reference to a project 
changes a bit depending on the project type. In fact, in a .NET Core project, you right-click the 
Dependencies node in the Solution pad, then you select Edit References; in Xamarin and 
.NET projects, you right-click the References node in the Solution pad, then you select Edit 
References. Regardless of the project type, Edit References opens up the Edit References 
dialog, where you will be able to select libraries with the help of four different tabs: All, 
Packages, Projects, and .Net Assembly. Figure 21 shows an example based on a Xamarin 
project. 

  

Figure 21: The Edit References dialog 
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The Packages tab lists installed libraries that Visual Studio is able to detect as available for the 
current project. The Projects tab allows you to add a reference to other projects in the solution, 
which is very common when you have class library projects that expose custom objects or APIs. 
The .Net Assembly tab shows a list of .NET assemblies that are currently referenced by the 
project. For instance, you could simply double-click a library listed in the Packages tab to 
immediately add a reference. If the library you need is not listed but available on disk, you can 
click Browse, locate the library, and select it to add a reference. At this point, you will be able to 
consume the objects exposed by the library in your code. 

This approach to adding dependencies has three important limitations:  

• It requires you to have the library on your disk. 
• It does not automatically resolve any additional dependencies that the library you are 

referencing might rely on, so this is something you must take care of manually. 
• It makes it difficult to manage different versions of the library and its dependencies once 

new versions are available. For instance, if a new version of a library is available and 
also relies on an updated version of a dependency, you must take care of both manually. 
The same concept applies if you want to downgrade to a less-recent version. 

NuGet solves all these problems. 

The NuGet package manager 

NuGet is an integrated package manager that has been very popular among developers using 
Microsoft Visual Studio on Windows and Xamarin Studio since its introduction in 2010. Through 
a convenient, integrated user interface, the NuGet Package Manager allows you to download 
and reference a huge number of popular libraries, and it also automatically resolves any further 
dependencies that a library might need. 

NuGet makes it extremely easy to manage different versions of a library and its dependencies. 
Libraries are bundled into the so-called NuGet packages, which are files with the .nupkg 
extension that contain the library itself, metadata that help developers identify a library, and 
information about dependencies that a library needs to be consumed properly. 

NuGet packages are hosted on (and can be published to) an online repository available at 
NuGet.org. If you visit this website, you will be able to browse the gallery outside of Visual 
Studio and see what’s available. I recommend that you spend some time getting familiar with 
NuGet because it is becoming the de facto standard for managing dependencies in both Visual 
Studio for Mac and Visual Studio on Windows. 

As a general rule, in the Solution pad you right-click the Dependencies node for .NET Core 
projects and the References node for Xamarin and .NET projects, then you select Add NuGet 
Packages. This will open the Add Packages dialog that you can see in Figure 22. 

http://www.nuget.org/
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Figure 22: The Add Packages dialog 

The Add Packages dialog shows the list of available packages from NuGet.org. For each 
package, you can see the description, author, publication date, number of downloads, and, very 
importantly, the license agreement and the additional dependencies the package requires. By 
default, only stable releases are displayed, but you can select the Show pre-release packages 
check box to show pre-release versions also. In the Version drop-down box, you see the latest 
version available by default, but you can pick a different one. 

When you select a NuGet package for installation, Visual Studio will show a dialog that contains 
a list of all the libraries that will be installed and a link to the license agreement for each. When 
you’re ready, click Accept to accept the license agreement for all the libraries. While Visual 
Studio downloads and installs the NuGet package with its dependencies, you will see the 
operation progress in the status bar. When it’s finished, in the Solution pad you will see a new 
node called NuGet under Dependencies. If you expand this node, you will see the library you 
just installed and the list of dependencies that the library relies on, if any. See Figure 23 for an 
example based on the Newtonsoft.Json package. 
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Figure 23: Browsing NuGet packages and their dependencies 

When a NuGet package and its dependencies are installed, Visual Studio for Mac automatically 
adds a reference so that you can consume libraries in your code. If you want to install a different 
version of an already installed package, you have two options. 

The first option is automatically updating NuGet packages to the latest stable release available, 
which you do by right-clicking the solution name in the Solution pad and then selecting Update 
NuGet Packages, or by selecting Project > Update NuGet Packages. 

The second option allows you to select a specific version of a NuGet package: simply right-click 
the NuGet node and select Add Packages. Select the package you want to upgrade (or 
downgrade), select the version number in the Version drop-down box, and click Add Package. 

Whenever Visual Studio for Mac performs any operations related to NuGet packages, it displays 
the output into the Package Console pad, which you enable with View > Pads > Package 
Console. Figure 24 shows an example. 

 

Figure 24: The Package Console pad 
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 The Package Console pad is particularly useful when installing NuGet packages fails because 
it provides detailed messages. A common reason for failure is selecting a NuGet package that is 
not compatible with the current project, or a dependency of the selected NuGet package that is 
not compatible with the current project. 

The way NuGet packages are managed is a little bit different depending on the development 
platform you are working on. For .NET Core, the list of required NuGet packages is stored 
inside the .csproj project file. Additionally, when NuGet packages are downloaded, they are 
stored inside a local cache for easy reuse. For other project types, such as Xamarin and full 
.NET, NuGet packages are downloaded into a project subfolder called Packages, and Visual 
Studio stores the list of required packages inside a file called Packages.config. In both cases, 
Visual Studio for Mac always knows what NuGet packages a solution needs. This is important 
because, if a library is missing, Visual Studio can easily restore it. 

For example, if a solution is under source control, it’s not uncommon that libraries are not sent 
to the server. So, when you download a solution from the Git source control repository of your 
choice for the first time, VS for Mac will check whether all the NuGet packages are available 
locally. If not, it will perform a restore operation. 

Another example of when restoring NuGet packages is required is when you share a solution 
with other people, such as in the form of a .zip archive or on a website. Because your solution 
might rely on a large number of packages, you can exclude them from the archive to save a lot 
of space. This is typical with Xamarin or full .NET projects, where you can completely delete the 
content of the Packages subfolder. When other people open the solution on their machines, 
Visual Studio checks if the required libraries are available; if not, it reads the content of 
Packages.config, and then it performs a restore operation. 

Usually, restoring NuGet packages occurs automatically when you open a solution, but you can 
restore packages manually by right-clicking the solution name in the Solution pad and selecting 
Restore NuGet Packages or by selecting Project > Restore NuGet Packages. 

Chapter summary 

The integrated development environment in Visual Studio for Mac is very powerful and offers 
everything you need to develop high-quality applications with the most productive tools. With 
pads, you can easily enable specific tools based on the context. The code editor, where you 
spend most of your developer life, not only provides syntax colorization for all the supported 
languages, but also advanced word completion with IntelliSense and live static code analysis 
that detects code issues as you type and provides quick fixes and refactorings. 

Many tools are available to help you quickly navigate among code files and between types and 
members. Finally, VS for Mac makes it easy to manage dependencies, especially with NuGet 
packages that help developers work with libraries that have one or more dependencies. After 
this overview of what the IDE offers, it is time to walk through the powerful debugging 
instrumentation. 
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Chapter 3  Debugging Applications 

Debugging is one of the most important parts of the application lifecycle, and Visual Studio for 
Mac offers unified, powerful tools for all the supported types of applications. This chapter walks 
through the available tools and provides useful tips. 

Available debuggers 

Visual Studio for Mac leverages debuggers that ship with the two major frameworks it relies on. 
For .NET Core, Visual Studio relies on the Microsoft .NET Core Debugger, which is included in 
the .NET Core SDK you installed in Chapter 1. This is the same debugger used by 
environments such as Visual Studio Code and Visual Studio on Windows against .NET Core 
apps. For Xamarin, Visual Studio leverages the Mono Soft Debugger, a specific debugger for 
Mono. Its main characteristic is that it is an integrated debugger built into the Mono framework, 
which is different from most debuggers, which are stand-alone processes.  

The goal of this chapter is not to explain what happens behind the scenes of the debuggers. 
Rather, it is to explain the powerful, unified tools that the IDE provides to debug applications 
regardless of the backing debugger. Obviously, Android and iOS are two different systems and 
therefore, the Mono Soft Debugger will send different kinds of messages depending on the 
current platform. The same concept applies to the Microsoft .NET Core Debugger, whose 
behavior is totally different from Mono Soft, and which will show its own messages and have its 
own characteristics. 

Setting up an example 

Before you learn about all the powerful debugging tools, it is necessary to write some code 
containing intentional errors that can be used for demonstration purposes. By following the 
steps you saw in Chapter 2, create a new .NET Core Console application in C# and write the 
code shown in Code Listing 1. 

Code Listing 1 

    // Add a using System.IO; directive. 
    class Program 
    { 
        static void Main(string[] args) 
        { 
            string welcomeMessage = "Please wait..."; 
            Console.WriteLine(welcomeMessage); 
 
            string content; 
 

https://bit.ly/2p4MwHc
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            // Attempt to open a text file from disk. 
            FileStream fileStream = new FileStream("file.txt",  

                       FileMode.Open); 
            using (StreamReader reader =  

                  new StreamReader(fileStream)) 
            { 
                content = reader.ReadLine(); 
            } 
 
            // Show the file content. 
            Console.WriteLine(content); 
 
        } 
    }  

The code is very simple: it shows a message stored inside a variable and then tries to read the 
content of a text file that will be shown onscreen, assuming the file exists. Notice that storing a 
message inside a variable rather than passing it directly as an argument to 
Console.WriteLine and missing a try..catch block to handle I/O exceptions are intentional 

errors, and are required to demonstrate how to leverage some of the debugging tools in the 
IDE. 

 Note: From now on, you will start either the sample application or any application 
you want to use for learning purposes with an instance of the debugger attached. As 
you learned in Chapter 2, this is accomplished via Run > Start Debugging or via the 
Start button on the standard toolbar. 

Reading the output from the debugger 

During the whole application lifecycle, Visual Studio shows any messages that the debugger 
sends into the Application Output pad. Figure 25 shows an example based on the sample code 
provided previously, where you can also see how the debugger captured an exception. 
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Figure 25: The Application Output pad 

The Application Output pad is of crucial importance when debugging, because it shows all the 
flow of information that the debugger sends, and this is of particular importance in case of 
runtime problems and exceptions raised by your application, or errors that the system might 
encounter when hosting your application. As with any other pads, the Application Output pad 
can auto-hide and be docked to a different position in the IDE for your convenience.  

Working with breakpoints and data visualizers 

Breakpoints are probably the debugging tool you will use most frequently. They basically allow 
you to control the execution flow of your applications. A breakpoint causes an application to 
break its execution at the point where the breakpoint itself was placed. This is also known as 
break mode. When a breakpoint is hit and the application execution breaks, you can take the 
necessary actions, such as investigating variable values at that point of the execution or 
executing code line by line. The easiest way to add a breakpoint is by clicking the leftmost 
column in the code editor, corresponding to the line of code that you want to be the point at 
which the application execution breaks. A breakpoint highlights the line of code in red, as shown 
in Figure 26. 

 

Figure 26: Breakpoints highlight in red a line of code 
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 You can add multiple breakpoints in different code files in order to control the execution flow. 
Now start debugging the application to see how breakpoints work. When the debugger 
encounters a breakpoint, it breaks the execution and highlights in yellow the line of code that is 
being debugged, before the line is executed, as demonstrated in Figure 27.  

 

Figure 27: A breakpoint has been hit 

Once the breakpoint has been hit and the line of code is highlighted in yellow, you can perform 
many actions, such as debugging in steps (discussed shortly) or investigating the content of 
objects and variables with the so-called data visualizers. Data visualizers are small pop-ups that 
appear when you hover over a local variable, field, or property, and that display their contents at 
that particular point in time. For example, if you hover over the welcomeMessage variable, you 

will see a data tip that shows its value (see Figure 28). 

 

Figure 28: Investigating variables with data visualizers 

In this case, the value for welcomeMessage has been supplied in code, but data visualizers are 

extremely useful when variables contain the result of a calculation or of the evaluation of an 
expression, and they allow you to see if the actual value is the expected result. If not, you can 
perform additional investigations to see what the problem was. You can also pin a data 
visualizer to the code editor by clicking the icon at its right side. 

Data visualizers are also available in the Locals pad, discussed shortly. You will use data 
visualizers many times while debugging, because they quickly help you understand if objects 
are populated as expected. For now, just press Start in the toolbar to resume the application 
execution. In the next section, you will learn more about executing code in steps. 

www.dbooks.org

https://www.dbooks.org/


 

50 

Configuring breakpoints 

Breakpoints can be configured so that you can decide when and how they should condition the 
application execution. If you right-click the red glyph of a breakpoint and then select Edit 
Breakpoint, you will access the Edit Breakpoint dialog. Here you can specify conditions and 
actions. Conditions determine when the debugger should break the application execution when 
it encounters a breakpoint, whereas actions allow special tasks to occur when a breakpoint is 
hit. They can work together to give you maximum control over the execution flow. Figure 29 
shows how the Edit Breakpoint dialog appears. 

 

Figure 29: Editing a breakpoint’s configuration 

In the Breakpoint Action group, the default selection is Pause the program, which simply 
causes the debugger to break the application execution when a breakpoint is hit. This is the 
behavior you saw when running the sample code after placing a breakpoint. As an alternative, 
the Print a message and continue option will not break the application execution; instead, it 
will show a message in the Application Output pad. The interesting thing is that, in the message, 
you can interpolate any C# expression within curly braces, which is useful to evaluate the value 
of a variable or of an object’s properties. In the When to Take Action group, there is only one 
option, called When a location is reached. The value of this setting is the file name and line of 
code where the breakpoint is currently placed, and since this is a read-only setting, you cannot 
change it.  

About conditions: by default, the application enters into break mode every time a breakpoint is 
encountered. However, sometimes you might want to place breakpoints but break the 
application execution only if a certain condition is true.  

For example, if you are iterating a collection with a foreach loop, you might want to break the 

application execution only after a certain number of iterations. To accomplish this, you can 
select one of the available conditions from the Advanced Conditions combo box (see Figure 
29). You can see how the name of each condition starts with When hit count is. With “hit,” we 
mean each time a breakpoint is encountered, and therefore, the application execution should 
stop. In other words, conditions allow you to control the hit’s behavior.  

For example, the When hit count is greater than or equal to condition will cause the 
application execution to break only after a breakpoint has been hit for a number of times that is 
greater than or equal to the number that you specify with the selector on the right. Other 
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condition names are self-explanatory, and the behavior of each condition is similar, except that 
the condition will be less than or greater than.  

You can also specify additional conditions with the And the following condition is true and 
And the following expression changes options. The first option allows you to specify a C# 
expression that must be evaluated to true in order to break the application execution, whereas 
the second option allows you to decide that an application should enter break mode when the 
value of the supplied C# expression changes. In summary, conditions and actions are very 
useful when you want a breakpoint to be hit only under certain circumstances, and they allow for 
a better execution flow. 

Function and exception breakpoints 

Previously, you saw how to add a breakpoint the easy way, and then you saw how to edit a 
breakpoint with conditions and actions. Visual Studio for Mac also allows you to specify 
conditions and actions, and also other options, directly when adding a new breakpoint by right-
clicking the leftmost column in the code editor and then selecting New Breakpoint. This will 
open the Create a Breakpoint dialog, which looks like Figure 30. 

 

Figure 30: Function and exception breakpoints 

Most of the options are the same as we discussed for the Edit Breakpoint dialog. Additionally, 
you will find the following two actions in the When to Take Action group: When a function is 
entered and When an exception is thrown (the default action is hitting the breakpoint when 
it’s encountered). The first action is also referred to as a function breakpoint, whereas the 
second option is also referred to as an exception catchpoint.  

A function breakpoint will cause the debugger to break the application execution when the 
specified method call is invoked, regardless of its position in the code. An exception catchpoint 
will cause the debugger to break the application execution when the specified exception is 
thrown at runtime, regardless of where it happens. The very interesting thing is that both options 
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are unrelated to any line of code; they will act as breakpoints, but they really do not need a 
breakpoint in the code editor. Visual Studio keeps track of function breakpoints and exception 
catchpoints and allows you to control them in the Breakpoints pad, as you will discover shortly. 
When you’re ready, click Create and a breakpoint will be placed on the current line of code. 

Analyzing runtime errors 

Runtime errors happen during the application execution, and they are typically due to 
programming errors that are not visible at compile time and that might involve unpredictable 
situations. For example, if an application gives users the ability to read a file, but then the file is 
not found on disk, a runtime error will occur. As an additional example, if an application attempts 
to connect to a database that is unreachable for network connectivity issues, a runtime error will 
occur. 

Obviously, in real-life applications, it is your responsibility, as the developer, to predict such 
possibilities and implement the appropriate try..catch blocks. However, unhandled runtime 

errors might occur for various reasons and the debugger in Visual Studio for Mac offers the 
proper tools to help you understand the cause of the problem. 

If you run the sample code provided at the beginning with no breakpoints, after a few seconds, a 
runtime error will cause the debugger to break the application execution, because the code is 
searching for a file that does not exist. At this point, Visual Studio highlights the line of code that 
caused the error and will show a tooltip that contains the exception name and the error 
description, as shown in Figure 31. 

 

Figure 31: Details about runtime exceptions 

In this case, the code failed because it was searching for a file that does not exist, so a 
FileNotFoundException error was thrown and was not handled by any try..catch block; 

therefore, the execution of the application was broken. Visual Studio shows the name of the 
exception that was raised and the filename that was not found (this is included in the exception 
message). Actually, Visual Studio allows you to investigate an exception further and retrieve all 
the details that the debugger was able to collect. To accomplish this, click Show Details, which 
opens the Exception Caught dialog (see Figure 32). 
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Figure 32: Viewing an exception’s details 

The Exception Caught dialog shows all the information about the exception and, because an 
exception is a .NET type that inherits from System.Exception, you will see the list of the 

exception properties, depending on the specialized exception type (in the case of a 
FileNotFoundException, you will see the FileName property showing the file that was not 

found). 

At the top of the dialog, the StackTrace item shows the hierarchy of calls to classes and 

methods that effectively produced the error. By default, StackTrace only shows information 

from your code, so if you want to see the entire call hierarchy, you need to disable the Only 
show my code option at the bottom. 

The InnerException property is also very useful. In our particular case example, it is set to 

null, but it’s not unusual for this item to show an exceptions tree that enables you to better 

understand what actually caused an error. The Exception Caught dialog also allows you to 
investigate property values further with data visualizers, so you can hover over a property name 
or its value and enable the proper visualizer. 

Executing code in steps 

When the application execution breaks, such as when the debugger encounters a breakpoint, 
you have different options to continue the execution. For instance, you can completely resume 
the execution, or you can just execute one line of code at a time or small sets of lines of code at 
a time. To accomplish this, you use a number of commands that are available in the Run menu 
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and in the debugging toolbar (and through the related keyboard shortcuts). These commands 
are described in Table 4. 

Table 4 

Commands to execute code in steps 

Command Description 

Continue debugging Resumes the application execution from 
the point at which it broke. 

Step Into Executes one instruction per time. It is 
similar to Step Over, but if the instruction 
to be executed is a method, the method is 
executed one instruction per time and, 
when finished, the execution goes back to 
the caller. 

Step Over Executes one instruction at a time. The 
difference from Step Into is that if the 
instruction to be executed is a method, the 
debugger does not enter the method and 
completes its execution before going back 
to the caller. This can be useful when you 
need to debug a portion of code that 
invokes several methods you already 
tested and do not need to delve into each 
time. 

Step Out Executes all lines of a method next to the 
current one, until the method completes. 
Step Out does not work outside of 
methods. 

Run To Cursor Allows running all the code until the 
selected line. You call it by right-clicking a 
line of code, and then selecting Run To 
Cursor. 

Set Next Statement Within a code block, allows setting the next 
statement to be executed when resuming 
the application execution after a breakpoint 
or stop. 

Show Next Statement Moves the cursor to the next executable 
statement. This can be useful if you have 
long code files and breakpoints are not 
immediately visible. 
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Commands to execute code in steps 

Show Current Execution Line Moves the cursor to the current statement. 
Useful with long code files when the cursor 
is in a totally different place. 

The Run To Cursor, Set Next Statement, Show Next Statement, and Show Current 
Execution Line commands are not available in the Debug toolbar, and you can find them in the 
Run menu or by right-clicking the code editor. 

The Debug pads 

In order to make it easier to analyze an application’s behavior, Visual Studio for Mac provides 
special pads that you can use while debugging. Visual Studio automatically shows these pads 
when you start debugging an application. If you decide to close one or more pads while 
debugging, you can always re-enable them individually with View > Debug Pads, and you can 
also enable them all with View > Debug. 

The Breakpoints pad 

The Breakpoints pad provides a visual representation of all the breakpoints in a solution, plus a 
number of shortcuts that make it easier to add, edit, and remove breakpoints. Figure 33 shows 
an example where you can see a breakpoint and an exception catchpoint. 

  

Figure 33: The Breakpoints pad 

 

The Breakpoints pad shows the list of breakpoints, function breakpoints, and exception 
catchpoints, each recognizable by a specific icon. For breakpoints, it shows the code file, the 
line number, and the hit count if a condition has been specified. While debugging, the hit count 
will increase every time the breakpoint is encountered. You can double-click a breakpoint and 
the code editor will move the cursor to the line where the breakpoint is. You can also disable 
one or more breakpoints using the check box on the left side. The pad’s toolbar has a button 
that allows you to disable, remove, edit, and add breakpoints. 
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The Locals pad 

The Locals pad shows the active local variables and their values while debugging. Figure 34 
shows an example where you can see active variables for the sample code provided previously, 
when stepping into the Main method. For example, you can see how the value for the 

welcomeMessage variable is Please wait…. This is very useful, especially with local variables 

whose value is the result of an evaluation or assignment.  

  

Figure 34: The Locals pad 

For each variable, the Locals pad shows not only the name and value, but also the type. When 
a variable has not been initialized, it shows the default value (such as null for reference types or 
zero for integers). You can hover over a variable and view its content with data visualizers, and 
you can even change a variable’s value by double-clicking each one. In the Locals pad, data 
visualizers also show an appropriate preview based on the variable type. For instance, if a 
variable represents a color, the data visualizer will show a box that depicts the color and shows 
the RGB properties, not just the C# value. Specific previews are available for types that 
represent location coordinates, images, size, points, Bezier curves, collections that implement 
the IEnumerable interface, and of course, strings. 

The Watch pad 

The Watch pad allows for monitoring object variables, methods, or expressions so that you can 
monitor what a variable is doing. When in break mode, you can enter the Watch pad and type in 
the name of a variable. Visual Studio will show the value for the variable at that specific time 
(see Figure 35). 

  

Figure 35: The Watch pad 

You need to step into the code and wait for an expression to be evaluated and assigned to the 
variable you entered in the Watch pad. The pad will be updated every time the result of the 
evaluation changes. 
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The Call Stack pad 

The Call Stack pad allows you to view the hierarchy of method calls. By default, Call Stack 
shows only calls in your code, but you can right-click and select Show External Code to see 
calls to external code such as native functions. Figure 36 shows an example based on the 
application code, with no external code. 

  

Figure 36: The Call Stack pad 

You can right-click the view and select a number of options, such as Show External Code, to 
visualize calls to native functions, or you can select Columns > Language to see the 
programming language with which a method was written. Call Stack is particularly useful with 
exceptions, because it helps walk you through the hierarchy of method calls so that you can 
understand the actual origin of the exception. 

The Threads pad 

As you know, many applications can run multiple threads, and this is also true for .NET Core 
and Xamarin applications. In order to get a view of running threads, you can open the Threads 
pad. It shows a list of running threads with summary information such as the thread ID, the 
name (where available), and a reference to the code that is related to that thread (see Figure 
37). 

  

Figure 37: The Threads pad 

This pad can be useful with multithreaded applications, when you need to understand what 
thread a specific code block is referring to. 
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Chapter summary 

In this chapter, you have walked through important features such as breakpoints, which allow 
you to control the execution flow of your code, and commands that allow you to execute your 
code step by step. With the help of data visualizers, you can always investigate variables’ 
contents while debugging. VS for Mac also provides a number of pads that are specific for 
debugging, and in this chapter, you saw which pads are available and what you can do with 
them to analyze your code and your applications’ behavior. You now have all the necessary 
knowledge about working with Visual Studio’s IDE, and now you can finally start putting your 
hands on some code. 
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Chapter 4  Creating .NET Core Apps 

The .NET Core can be thought of as a subset of the .NET Framework that runs on Windows, 
macOS, and Linux. More specifically, .NET Core is a cross-platform, open source, modular, and 
general-purpose development platform included in the .NET Foundation (dotnetfoundation.org) 
that Microsoft supports and maintains together with the .NET developer community.  

The .NET Core also runs on devices, which may include mobile devices and IoT devices, so it is 
not limited to classic desktop and server environments. It is a modular framework in that it ships 
as NuGet packages, and the idea is that an app built on top of .NET Core will include only the 
libraries (modules) it actually needs, instead of relying on a full framework, as is the case with 
.NET Framework. This chapter explains what .NET Core consists of and shows how to create 
.NET Core apps with Visual Studio for Mac.  

 Note: In the pure spirit of the Succinctly series, this chapter cannot explain in full 
detail the MVC programming pattern and the ASP.NET Core APIs for web apps. The 
chapter instead focuses on the IDE tools to generate and maintain applications, 
simplifying the lifecycle.  

.NET Core architecture 

.NET Core is made of several fundamental parts that work together to bring all the power, 
flexibility, and compatibility for this amazing technology. The following subsections provide a 
high-level overview of the parts that compose .NET Core. 

The .NET Core runtime 

The .NET Core runtime, known as CoreCLR, is a portable, cross-platform component that 
provides applications an execution environment. The CoreCLR includes a type system with 
base .NET data types, the Just-in-Time compiler (JIT), a garbage collector, and a base class 
library called mscorlib.  

CLR stands for Common Language Runtime, and it basically means that all .NET apps run on 
the same runtime platform, regardless of the programming language they have been written 
with. Different from the full .NET Framework, where applications need .NET to be installed on 
the target system to take advantage of the Common Language Runtime, with .NET Core the 
CoreCLR is packaged together with the application and the required libraries. This avoids the 
need for a pre-installed runtime. The CoreCLR is an open-source project available on GitHub. 

.NET Core libraries 

While the .NET Core runtime includes the base class library, additional types are necessary for 
serious development. .NET Core provides a large number of libraries that ship as NuGet 
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packages and expose types for file access, collections, XML, and so on. Providing the full list of 
.NET Core libraries is not necessary, since Visual Studio for Mac will automatically include the 
appropriate libraries when creating MVC and Web API projects. 

.NET Core SDK: Tools and languages 

The .NET Core SDK is the set of tools you need to build applications for .NET Core. This 
includes the .NET Command Line Interface (CLI) and the programming languages with 
compilers. The command line interface is covered in more details in the next section, but first a 
few words about programming languages. 

Currently, .NET Core allows you to write applications using C# and F#. The implication is that 
you can write C# and F# code not only on Windows, as you could do in the past, but now also 
on macOS and Linux. This is possible because Microsoft has been working hard to make these 
popular programming languages cross-platform. 

 Note: In .NET Core, you basically do everything via the command line interface, 
so it is very important. However, programs like Visual Studio for Mac invoke the 
appropriate commands behind the scenes on your behalf, so you do not need to 
interact with it directly. In this book, the .NET Core CLI is not discussed further, but 
you can have a look at the documentation for details about all the commands. 

Supported .NET Core project types 

Visual Studio for Mac supports the .NET Core project types summarized in Table 5, all available 
through the New Project dialog.  

Table 5 

Available .NET Core project types 

Project Type Description 

Console Application Generates a solution that contains a C# 
project for a stand-alone, empty Console 
application.  

ASP.NET Core Empty Generates a solution that contains an 
empty ASP.NET Core web project. 

ASP.NET Core Web API Generates a solution that contains an 
ASP.NET Core project that scaffolds a 
RESTful service based on the Web API 
framework. 

ASP.NET Core Web App Generates a solution that contains an 
ASP.NET Core project that scaffolds a 
web application based on Razor pages. 

https://docs.microsoft.com/en-us/dotnet/core/tools
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Available .NET Core project types 

ASP.NET Core Web App (MVC) Generates a solution that contains an 
ASP.NET Core project that scaffolds a 
web application based on the MVC 
framework, with views and controllers. 

 Note: In the New Project dialog, you will also see the Library and Tests project 
categories. These allow for creating reusable libraries and automated tests, but they 
won’t be covered in this chapter. You can read the description of the project 
templates in the New Project dialog. 

You already saw an example of Console applications previously, so in this chapter you will 
create a Web MVC application that contains the basic infrastructure for a fully-functional website 
with pages. 

Web applications with Visual Studio for Mac 

For the first time with .NET Core, you can create web applications that span across platforms 
using C#. This is a tremendous benefit, because you are no longer limited to publishing your 
.NET web apps to Windows hosts (including Azure), and you can easily deploy web applications 
to Mac and Linux servers reusing your existing C# skills. 

In this chapter, you will learn how to create an ASP.NET Core web application and how to 
publish it to Microsoft Azure as the host directly from Visual Studio for Mac. You will see how 
the IDE simplifies the whole application lifecycle, from development to deployment. More 
specifically, you will see how the built-in project templates make it easy to create an application 
with pages and controllers, and how you can quickly deploy an application to Microsoft Azure. 

Introducing ASP.NET Core 

ASP.NET Core is an open-source and cross-platform framework for building modern, cloud-
based connected applications such as web applications, IoT apps, and mobile back ends. 
ASP.NET Core provides an optimized development framework for applications that are 
deployed to the cloud or run on-premises, and that consist of modular components. The source 
code for ASP.NET Core is available on GitHub and Microsoft is accepting contributions from the 
developer community. 

Like .NET Core, ASP.NET Core ships entirely as NuGet packages for improved modularity, and 
both applications and services can be hosted on Internet Information Services or self-hosted in 
your own process. As you will see later in this chapter, ASP.NET Core inherits from ASP.NET 
the so-called model binding, a runtime feature that can map parameters passed with HTTP 
requests to properties of .NET objects. 
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Put succinctly, ASP.NET Core will be your framework of choice if you want to build web apps 
and services that run cross-platform, are fully testable, and can be deployed easily regardless of 
whether the host is cloud-based or on-premises. In a layered architecture, ASP.NET Core is a 
layer upon the .NET Core architecture described previously, so it relies on the CoreCLR, the 
core libraries and NuGet packages, the C# compiler built upon Roslyn, and .NET Standard. 

Introducing MVC 

MVC stands for Model-View-Controller, which is the name of a programming pattern built on top 
of the following elements: 

• Model: The business objects that represent the data an application needs to work 
with. 

• Controller: An intermediate object that exposes and manages the model based on 
the business logic rules. 

• View: The user interface of an application that invokes actions in a controller based 
on the user input and displays the result. 

In ASP.NET and ASP.NET Core, the model is made of C# classes that represent your data. For 
example, a C# class that maps a table in a database is part of the model. Controllers are C# 
classes that implement business logic, such as queries or C.R.U.D. (Create, Read, Update, 
Delete) operations. The view is the full user interface made of HTML pages that invoke 
operations in controllers, like when the user clicks a button to load or insert data. For example, if 
you build an application for order management, an Order class might be the model that 

represents the Orders table in the database, an OrderController could expose methods that 

allow querying, adding, and updating orders, and then you might have an HTML page that 
displays the list of active orders and controls that allow adding or updating orders based on the 
user input. 

Notice that models and controllers are not limited to working against databases: in fact, you can 
map anything you need with a business object, and you can even execute operations from 
controllers without having a model, for example, when you call a web service. Additionally, the 
ASP.NET Core MVC framework supports identity management and automatically provides 
plumbing code that configures an app startup. 

Scaffolding an MVC application 

In Visual Studio for Mac, click New Project in the Welcome page (or select File > New 
Solution). In the New Project dialog, select the ASP.NET Core Web App (MVC) project 
template, then click Next (see Figure 38). 
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Figure 38: Selecting the MVC project template 

In the next dialog, select the version of .NET Core you want to target. The number of versions 
available varies depending on your configuration, but you can select the highest version 
available for consistency. Click Next and, in the third and last dialog, enter a name for the 
sample project, as shown in Figure 39. As you can see, a preview of the structure of the solution 
is visible at the right corner of the dialog, along with the option to create a solution file and to 
associate the solution to the Git version control. 

 

Figure 39: Specifying a project name 

Click Create and, after a few seconds, the solution will be ready. An MVC solution has a 
particular structure whose elements are described in Table 6. 

Table 6 

Common elements in MVC solutions 

Name Scope Description 

www.dbooks.org
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Common elements in MVC solutions 

Dependencies Folder Contains the NuGet packages 
and the SDK libraries required 
by the application. 

Controllers Folder Contains the C# controller 
classes that implement the 
application’s business logic.  

Views Folder Contains .cshtml files and 
subfolders with other .cshtml 
files that define the user 
interface of the application. 

Wwwroot Folder Contains all static files such 
as assets, fonts, cascading 
style sheets (CSS) files, 
JavaScript files, and HTML 
files. It also contains all the 
necessary JQuery files. 

favicon.ico File The icon of the application as 
it will appear in the web 
browser. 

bower.json File Contains a list of client-side 
Bower packages that 
represent additional 
dependencies. 

appsettings.json File Allows defining application 
settings with the JSON 
notation. 

appsettings.development.json File Allows defining application 
settings with the JSON 
notation that you can use at 
development time. 

Program.cs File Defines the Main C# method 

that is the main application 
entry point and allows 
configuring the application 
host.  

Startup.cs File Defines MVC routing 
strategies and allows you to 
configure framework services 
and host settings. 
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Under the Views > Home subfolder, you can find several .cshtml files that represent the views 
or pages of the user interface. The code editor in Visual Studio for Mac has full support for these 
kinds of markup files and enables IntelliSense, as demonstrated in Figure 40.  

 

Figure 40: IntelliSense for .cshtml files 

Configuring project options 

Visual Studio for Mac provides you with deep control over project options and properties. You 
access the project options with Project, ProjectName Options (where ProjectName stands for 
your project name) or by right-clicking the project name in the Solution pad and selecting 
Options. The Project Options window appears at this point (see Figure 41). 

 

Figure 41: Configuring project options 
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In the General node, you find the Main Settings, which is the same for all the supported project 
types across VS for Mac. Here you can specify a different project name, a specific version 
number, an optional description, and the root C# namespace, and you can change the root 
directory where the project files are stored. By default, the project version is inherited from the 
solution version, but you can uncheck the Get version from parent solution check box and 
provide a new version. 

The other settings are generated based on the information you supplied when you created the 
project, and unless you have specific requirements, I recommend you leave them unchanged. 
These settings are also available to Xamarin projects. In the Build node of the Project Options 
dialog (see Figure 42), the General tab allows you to change the target framework, which is the 
latest .NET Core runtime version by default.  

 

Figure 42: Configuring build options 

In the Code Generation group, you can change the compile target (Executable, Library, 
Executable with GUI, or Module), the startup C# class in the Main Class box, the icon file in the 
Win32 Icon box, and the encoding code page for source files in the Compiler Code Page box. 
I recommend that you don’t change the default options, including the Do not reference 
mscorlib.dll check box value, because the default is already optimized for your project, and 
changing these options usually only makes sense for full .NET projects, not .NET Core projects.  

Additionally, you can specify the C# version the compiler should use in the C# Language 
Version box. The Default setting ensures the compiler uses the latest version of the language 
available. The Allow ‘unsafe’ code check box should be left unselected in a .NET Core project, 
as you will not typically invoke native code.  

The Custom Commands tab allows you to specify any actions that should be executed before, 
during or after a build or clean process. Actions are per configuration, so you can specify 
different actions for different configurations and, by default, the Configuration drop-down box 
shows the active build configuration, but you can choose a different one and provide any 
actions. You specify one or more actions with the Select Project Operation drop-down box. 
Supported actions are Before Build, Build, After Build, Before Clean, Clean, After Clean, 
and Custom Command. Figure 43 shows an example based on the After Build action. 
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Figure 43: Configuring custom commands 

You can specify the action that must be executed by supplying an application name in the 
Command text box (or you can click Browse instead of manually typing the name). Commands 
might need to receive parameters, for example, the solution or project name. Because VS for 
Mac identifies such parameters with special constants, you can select the appropriate constant 
by clicking the button with the arrow icon and selecting one of the self-explanatory values from 
the drop-down. The same applies to the Working Directory check box, where you can specify 
the directory in which the command should be executed.  

In Figure 43, you can see the $(SolutionDir) constant that represents the solution directory 

and is listed as Solution Directory in the Constants drop-down box. The Configurations tab 
allows you to manage build configurations. By default, it shows the Debug and Release 
configurations. You can add, duplicate, remove, and rename configurations with the Add, Copy, 
Remove, and Rename buttons, respectively. The Compiler tab allows you to influence the 
compilation process, and Figure 44 shows how it appears.  

 

Figure 44: Configuring compiler options 
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Compiler options are per configuration, and the default is the active build configuration, but you 
can select a different configuration in the Configuration drop-down box. In this way, changes 
you make in this tab will be applied when you build your solution using the specified 
configuration.  

In the General Options, the Generate overflow checks check box forces the compiler to 
check for integer calculations overflow and to throw an OverflowException at compile time if it 

finds any. Enabling this option could be useful to make integer calculations faster and avoid 
storing results without any errors. The Enable optimizations check box forces the compiler to 
optimize the build output, so the resulting application, library, or package might be smaller, 
faster, and more efficient. However, because the optimization process requires rearranging the 
code in many ways, the debugging experience could be more difficult and less complete. For 
this reason, this check box is automatically enabled only for the Release configuration. The 
Generate xml documentation check box makes Visual Studio for Mac generate an XML 
documentation file for your objects. You can specify an output file name in the text box. 
Selecting this option only makes sense if you commented your source code with XML 
comments.  

The Assembly Signing tab allows you to sign an assembly with a digital signature, also 
referred to as strong name. Supported files are .snk (“strong key”) and .pfx (“personal exchange 
format”) files. The .pfx format also allows for specifying a password, so it should be preferred. In 
order to specify a digital signature, enable the Sign this assembly check box, then click 
Browse to select your .snk or .pfx file from disk. In the Output tab, you can specify the 
assembly name and the directory for the build output if you want to change the default settings. 

Running and debugging  

If you press the Start button on the standard toolbar, the application will start for debugging and 
appears as seen in Figure 45.  

 

Figure 45: The MVC application running 
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Once the application is running, you will be able to use all the debugging tools discussed in 
Chapter 3. Debugging .NET Core applications relies on the .NET Debugger, an open-source 
and cross-platform debugger that Visual Studio for Mac attaches to a running .NET application. 
However, in the case of ASP.NET Core, this is not enough. In fact, a web application needs to 
be hosted on a web server in order to be started. 

If you have developed ASP.NET applications with .NET on Windows in the past, you had 
Internet Information Services (IIS) and Internet Information Services Express as available 
choices to host the application. These are only available on Windows, so .NET Core ships with 
a special, open-source development web server called Kestrel. Kestrel’s behavior is very similar 
to IIS Express, with the important difference that it runs across platforms, which means macOS, 
Linux, and Windows. 

With Kestrel, you can run, debug, and test your application as if it were on a real web server. As 
you would expect from a development server, the URL for the application always starts with 
http://localhost followed by the port number. You can simply click the address bar to see the 
current port number. If you wish to provide a different port number, you can right-click the 
project name in the Solution pad, then select Options and see the current value in the Default 
run configuration under Run > Configurations. The App URL field in the ASP.NET Core tab 
(see Figure 46) contains the current URL, and here you will be able to supply a different port 
number. 

 

Figure 46: Changing the Kestrel’s default port 

Publishing ASP.NET Core applications 

 Note: You need an active Azure subscription to complete the steps described in 
this section. You can request a free trial here. 

ASP.NET Core web applications can be published to any host supporting .NET Core, such as 
Internet Information Services, but Visual Studio for Mac has integrated support for automating 
the deployment to Microsoft Azure. To accomplish this, you can select Build > Publish > 
Publish to Azure. In the Publish to Azure App Service dialog, you will see the list of existing 
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Azure app services, if there are any, and a link to create a new app service. Click Create a new 
App Service.  

 

Figure 47: Creating a new app service 

At this point, you will need to specify the app service name, which will also become part of the 
web URL of the application. You will be able to select which Azure subscription (a billing 
mechanism) will host the application (in case you have more than one subscription), and a 
resource group, which can be thought of as an organization mechanism for related entities, 
such as an application and data storage for the app. As the name implies, a resource group in 
Azure contains multiple web resources, including applications.  

If you want to use one of the existing resource groups, pick one from the list or click the + button 
to create a new resource group. I recommend that you select the closest region to where you 
live in the Region combo box, and the F1 – Free plan in the Pricing combo box. Paid plans 
provide more computing resources, but for demonstration purposes, the free plan is enough. 
When you click Create, Visual Studio will start publishing the web application to the specified 
Azure app service. After a few minutes, your application will be ready to run on the Cloud at the 
URL defined in the New App Service dialog (see Figure 47). 

Testing with examples 

As I mentioned at the beginning of this chapter, it is not possible to discuss all the ASP.NET 
Core features and all the development scenarios you could address with this platform in Visual 
Studio for Mac. For this reason, it’s a good idea to look at how you could work with an end-to-
end example. More specifically, you can download the companion code for the ASP.NET Core 
official tutorials. The repository contains a lot of examples that span across development 
scenarios, including working with databases through the Entity Framework. I recommend that 
you take a look at these examples to better understand what you can do with ASP.NET Core. 

https://github.com/aspnet/Docs/tree/master/aspnetcore/data/ef-mvc/intro/samples/cu-final
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Chapter summary 

ASP.NET Core is the cross-platform, open-source, modular runtime for creating web 
applications that run on macOS, Linux, and Windows in C#. Visual Studio for Mac allows you to 
create ASP.NET Core web applications with convenient integrated tools that avoid using the 
command line interface. In the case of the MVC pattern, the IDE generates projects that 
implement model classes, controllers, and views. In this chapter, you have also discovered a 
new development web server called Kestrel that allows you to test and debug ASP.NET Core 
locally, together with the usual, powerful debugging instrumentation available in Visual Studio 
for Mac. In the end, you have seen how to publish an application to Microsoft Azure in only a 
few minutes with very few clicks, and how to be on the market in minutes. 
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Chapter 5  Creating Xamarin Projects 

Xamarin is the technology that allows developers to build native apps with C# for Android, iOS, 
macOS, Windows 10, and Tizen. In this chapter, you will get an overview of Xamarin 
development with Visual Studio for Mac, which offers a complete solution to build high-quality, 
cross-platform mobile apps by reusing your existing skills on the Microsoft stack. 

Introducing Xamarin and Xamarin.Forms 

With Xamarin, you can build native apps for multiple platforms using C# as the programming 
language. Xamarin provides libraries that wrap native APIs into .NET types and members, 
which allow for full access to all the iOS, Android, macOS, Windows 10, and Tizen capabilities.   

Support for additional platforms is added as Xamarin grows; for example, support for WPF is a 
work in progress. Platforms like Xamarin.iOS, Xamarin.Mac, and Xamarin.Android allow you to 
write C# code to create native apps for iOS, macOS, and Android, respectively. In situations 
where you instead need to build apps whose user interface elements are common to all 
platforms, Xamarin.Forms is an interesting choice, in that it allows you to target multiple 
platforms from a single, shared C# codebase. 

 Note: Xamarin is a huge technology and teaching how to build apps with Xamarin 
and Xamarin.Forms is not possible in this book. If you are interested in cross-
platform mobile app development, you can download for free Xamarin.Forms for 
macOS Succinctly and Xamarin.Forms Succinctly (Windows version) books by the 
same author of this book.  

Available project types 

Visual Studio for Mac ships with a large number of project templates for Xamarin development 
that are available in the New Project dialog. Figure 48 shows a few of them. 

https://www.syncfusion.com/ebooks/xamarin_forms_for_mac_os_succinctly
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Figure 48: Some of the Xamarin project templates 

Multiplatform project templates 

Let’s start with the Multiplatform category, which offers project templates that aim to maximize 
code reuse. In this category, you find templates that allow sharing code by platform, such as 
Xamarin.Forms, or by project kind, such as Shared Projects and .NET Standard libraries. 

The Multiplatform category is divided into three subcategories: App, Libraries, and Tests. 
Subcategories’ names are self-explanatory: App contains project templates that allow creating 
an app, Libraries contains project templates that allow producing reusable libraries, and Tests 
contains project templates that allow creating projects for UI test automation. You will find the 
same subcategories in the iOS and Android template categories as well. Table 7 lists the project 
templates in the App category. 

Table 7 

Project templates in the Multiplatform category 

Target platform Project type Description 

Xamarin.Forms Forms App Generates a solution that 
contains a cross-platform 
Xamarin.Forms project and an 
ASP.NET Web API back end 
based on .NET Core and 
optimized for publication to 
Microsoft Azure. The 

www.dbooks.org

https://www.dbooks.org/


 

74 

Project templates in the Multiplatform category 

Xamarin.Forms project 
contains sample data and 
sample views to simulate a 
To-do list app, including 
CRUD operations and 
authentication. 

Xamarin.Forms Blank Forms App Generates a solution that 
contains a blank 
Xamarin.Forms project. 

Native (iOS, Android) Native App (iOS, 
Android) 

Generates a solution that 
contains a Xamarin.iOS 
project, a Xamarin.Android 
project, and a project to share 
code between the two 
Xamarin projects. This can be 
either a shared project or a 
.NET Standard library. 
Xamarin projects include an 
ASP.NET Web API bac kend 
based on .NET Core and 
sample data and views to 
simulate a To-do list app, 
including CRUD operations 
and authentication. The back-
end project is optimized for 
distribution to Microsoft Azure. 

Native (iOS, Android) Blank Native App (iOS, 
Android) 

Generates a solution that 
contains blank Xamarin.iOS 
and Xamarin.Android projects, 
plus a project to share code 
between the two, which can 
be either a shared project or a 
.NET Standard library. 

Games (iOS, Mac) SpriteKit Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 2D 
games based on the SpriteKit 
framework from Apple. 

Games (iOS, Mac) SceneKit Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 3D 
games based on the SceneKit 
framework from Apple. 
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The Library category contains project templates that allow creating reusable libraries or shared 
projects. Table 8 lists the available project templates in this category. 

Table 8 

Project templates in the Library category 

Target Platform Project Type Description 

General Shared Project Generates a solution that 
contains a so-called Shared 
Project, which allows sharing 
loose assortments of files 
between projects. 

General Multiplatform Library Generates a solution that 
contains a Portable Class 
Library and a corresponding 
NuGet package that can be 
compiled and distributed to 
the NuGet gallery. 

General .NET Standard Library Generates a solution that 
contains a C# library based 
on the .NET Standard 
specifications. At the time of 
writing, Visual Studio for Mac 
supports version 2.0 of .NET 
Standard. 

Xamarin.Forms Class Library Generates a solution 
containing a .NET Standard 
Library that can be consumed 
by Xamarin.Forms projects. 

 Note: The .NET Standard specification provides a set of specifications for APIs 
that all the .NET development platforms, such as .NET Framework, .NET Core, and 
Mono, must implement. This allows for unifying .NET platforms and helps avoid 
future fragmentation. By creating a .NET Standard Library, you will be sure your code 
will run on any .NET platform without the need of selecting any targets. Microsoft has 
a blog post about .NET Standard, its goals and implementations that you can find 
here. 

The last category is called Tests, and contains only one template, called UI Test App. This 
project template generates a solution with a project that allows automating tests against the 
user interface both locally and on Xamarin Test Cloud, the platform that provides a cloud-based 
environment with dozens of devices you can use to test the behavior of your apps. 
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iOS and tvOS project templates 

The iOS category contains project templates that allow you to generate Xamarin.iOS projects 
you can use to build native iOS apps with C#. Table 9 offers a summary description of each 
template. 

Table 9 

Project templates in the iOS category 

Target platform Project type Description 

General Single View App Generates a solution that 
contains a Xamarin.iOS 
project for a single-page app 
with a Storyboard object that 
contains a View, a View 
Controller, and a C# class for 
imperative code. 

General Master-Detail App Generates a solution that 
contains a Xamarin.iOS 
project based on a Master-
Detail view and displays a list 
of sample items. It is 
optimized for different screen 
form factors, including a 
Navigation Controller for the 
iPhone and a Split View on 
the iPad. 

General Tabbed App Generates a solution that 
contains a Xamarin.iOS 
project based on multiple 
pages contained in tabs. It 
includes a Tab Bar Controller 
and a View Controller for each 
tab bar item. 

General Page-Based App Generates a solution 
containing a Xamarin.iOS 
project that shows how to 
implement navigation among 
multiple pages using a Page 
View Controller. 

General WebView App Generates a solution that 
contains a Xamarin.iOS 
project that allows displaying 
HTML content inside a 
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Project templates in the iOS category 

WebView object, based on 
the Razor templating engine. 

Games  SpriteKit Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 2D 
games based on the SpriteKit 
framework from Apple. 

Games SceneKit Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 3D 
games based on the SceneKit 
framework from Apple. 

Games Metal Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 
games based on Metal, a 
GPU-accelerated 3D 
framework from Apple. 

Games OpenGL Game Generates a solution 
containing a Xamarin.iOS 
project that allows creating 2D 
and 3D games based on the 
OpenGL framework APIs. 

The Library category offers two project templates: Class Library, which allows for generating C# 
class libraries that are tailored for Xamarin.iOS, and Bindings Library, a special project template 
that allows for generating C# class libraries that can consume third-party Objective-C libraries 
for iOS. This particular topic will not be covered in this book, but the Xamarin documentation 
has a specific page. 

The Tests category offers two project templates, called UI Test App and Unit Test App. The first 
project template is similar to its corresponding template in the Multiplatform category, but is 
tailored for Xamarin.iOS and allows for automating tests against the user interface, both locally 
and on Xamarin Test Cloud. The second template creates a test project for Xamarin.iOS apps 
and libraries in which you can write unit tests based on the Touch.Unit framework. About tvOS: 
Visual Studio for Mac offers project templates that generate Xamarin.iOS projects optimized for 
this kind of device. Supported project templates are Single View App, Tabbed App, SceneKit 
Game, SpriteKit Game, and Metal Game, and the description is the same as provided in Table 
9. 

Android project templates 

The Android category is still divided into three subcategories: App, Library, and Test. In general, 
the Android category contains project templates that allow generating Xamarin.Android projects 
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you can use to build native Android apps with C#. Table 10 offers a detailed description of each 
template. 

Table 10 

Project templates in the Android category 

Target Platform Project Type Description 

General Android App Generates a solution that 
contains a Xamarin.Android 
project with a single sample 
screen (Activity) with a button 
and a label. 

General Wear App Generates a solution 
containing a Xamarin.Android 
project that targets the 
Android Wear operating 
system. This project template 
works only with the API Level 
20 or higher. 

General Blank Android App Generates a solution that 
contains a Xamarin.Android 
project with a single sample 
screen (Activity) and empty 
user interface. 

General WebView App Generates a solution 
containing a Xamarin.Android 
project that allows displaying 
HTML contents inside a 
WebView object, based on 
the Razor templating engine. 

Games  OpenGL Game Generates a solution 
containing a Xamarin.Android 
project that allows creating 2D 
and 3D games based on the 
OpenGL framework APIs. 

Games OpenGL ES 2.0 Game Generates a solution 
containing a Xamarin.Android 
project that allows creating 2D 
and 3D games based on the 
OpenGL ES 2.0 APIs. ES 
stands for Embedded 
Systems. 

Games OpenGL ES 3.0 Game Generates a solution that 
contains a Xamarin.Android 
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Project templates in the Android category 

project that allows creating 2D 
and 3D games based on the 
OpenGL ES 3.0 APIs. This is 
the most recent version with 
new features and is backward 
compatible with 2.0. 

The Library category offers two project templates: Class Library, which allows for generating C# 
class libraries that are tailored for Xamarin.Android, and Bindings Library, a project template 
that allows for generating C# class libraries that can consume third-party Java libraries for 
Android. This particular topic will not be covered in this book, but the Xamarin documentation 
has a specific page. 

The Tests category offers two project templates, called UI Test App and Unit Test App. Similar 
to the iOS templates, the first project template is similar to its corresponding template in the 
Multiplatform category. However, it is tailored for Xamarin.Android and allows for automating 
tests against the user interface, both locally and on Xamarin Test Cloud. The second template 
creates a test project for Xamarin.Android apps and libraries where you can write unit tests. 

Project templates for macOS 

The Mac category provides project templates that allow building applications, games, and 
libraries for the macOS operating system using Xamarin.Mac with C#. This category is divided 
into the App and Library subcategories, and Table 11 describes templates the App category in 
more detail. 

Table 11 

Project templates in the Mac category 

Target Platform Project Type Description 

General Cocoa App Generates a solution that 
contains a Xamarin.Mac 
project with a Storyboard for a 
stand-alone Mac application 
based on the Cocoa 
framework from Apple.  

Games SpriteKit Game Generates a solution 
containing a Xamarin.Mac 
project that allows creating 2D 
games based on the SpriteKit 
framework from Apple. 

Games SceneKit Game Generates a solution 
containing a Xamarin.Mac 
project that allows creating 3D 
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games based on the SceneKit 
framework from Apple. 

Games Metal Game Generates a solution 
containing a Xamarin.Mac 
project that allows creating 
games based on Metal, a 
GPU-accelerated 3D 
framework from Apple. 

The Library category contains the Class Library and Bindings Library project templates. Their 
purpose is exactly the same as described for their counterparts in Xamarin.iOS, with an 
important clarification for the Class Library template: this one relies on the so-called Unified 
APIs, which means that code in this library can be shared between Xamarin.Mac and 
Xamarin.iOS on both 32-bit and 64-bit systems. 

Creating a Xamarin.Forms project 

Xamarin.Forms allows creating projects that target multiple platforms, such as iOS and Android, 
from a single, shared C# code base. Xamarin.Forms is essentially a library that wraps native 
controls into objects that you can use to code once, and then the runtime generates native apps 
that translate these objects into the appropriate platform-specific visual elements. You can 
create a variety of Xamarin projects in Visual Studio for Mac, but with Xamarin.Forms, you will 
get a better perception of cross-platform development made easy.  

Select File > New Solution, and then in the New Project dialog, select the Blank Forms App 
project template (see Figure 48), then click Next. In the second screen, specify a name for your 
project in the App Name text box (see Figure 49) and make sure you fill in the Organization 
Identifier text box. 
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Figure 49: Entering the project information 

The Organization Identifier is a very important field because both Android and iOS use it to 
uniquely identify your applications in Google Play and the App Store. By convention, the 
organization identifier has the following form: 

com.companyname.appname 

Where com. is a fixed prefix, companyname represents your company’s name, and appname 

represents the name of your application. You don’t actually need to enter the app name in the 
Organization Identifier text box, since Visual Studio will automatically concatenate it to the 
organization identifier you just supplied. 

In the Target Platforms group, you can select the platforms you want to target, such as Android 
and iOS. For now, leave both selected. The Shared Code group is of crucial importance, 
because it allows you to decide which code-sharing strategy you will use in your project: a .NET 
Standard library or a so-called shared project. They both have pros and cons, but for further 
details, make sure you read the Xamarin.Forms for macOS Succinctly ebook. 

For now, select the Use .NET Standard option, then click Next. In the final screen (see Figure 
50), you will have an option to review the project information and the structure of the solution, 
and you will be able to add the solution to source control with Git and to add a UI test project to 
the solution. Do not select these options, and just click Create. 
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Figure 50: Project summary information 

After a few seconds, the solution will be ready, and all its elements will be visible in the Solution 
pad, as demonstrated in Figure 51.  

 

Figure 51: The Xamarin.Forms solution visible in the Solution pad 
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The solution contains three projects: the first project is a .NET Standard library that contains all 
the code that can be shared across platforms, such as visual elements that exist in both iOS 
and Android (labels, text boxes, buttons, and so on). The other two projects are native 
Xamarin.Android and Xamarin.iOS projects, which will contain any platform-specific code you 
need to write in order to access APIs that Xamarin.Forms cannot share among platforms.  

In Xamarin.Forms and, more generally, with mobile app development, the user interface is 
presented with pages. When you create a Xamarin.Forms solution, a root page of type 
ContentPage is also provided in a file called MainPage.xaml. All the user interface in 

Xamarin.Forms is defined via the XAML (eXtensible Application Markup Language) language, 
which maps visual elements to XML nodes and their properties to XML attributes.  

For each page, defined in .xaml files, there is also a C# code-behind file, where you write the 
code that implements the logic and actions for the user interface. In the case of MainPage.xaml, 
the code-behind file is called MainPage.xaml.cs, and can be opened by expanding the 
MainPage.xaml item in the Solution pad.  

You will add new XAML files depending on how many pages you need in the application via File 
> New File. For example, say you replace the default XAML code of the MainPage.xaml file 
(which is the root page of the app) with the following. 

Code Listing  2 

<?xml version="1.0" encoding="utf-8"?> 
<ContentPage xmlns="http://xamarin.com/schemas/2014/forms" xmlns:x="http://
schemas.microsoft.com/winfx/2009/xaml" xmlns:local="clr-
namespace:XamarinFormsDemo" x:Class="XamarinFormsDemo.MainPage"> 
    <StackLayout> 

        <Label Text="Enter some text" HorizontalOptions="Center"  

               VerticalOptions="CenterAndExpand" /> 
        <Entry x:Name="InputBox" HorizontalOptions="FillAndExpand"/> 
         
        <Button x:Name="Button1" Text="Tap here"  

                Clicked="Button1_Clicked"  

                HorizontalOptions="FillAndExpand" /> 
    </StackLayout> 
</ContentPage>  

You will get a page with a root control container (StackLayout) that allows you to place multiple 

controls near one another, a text message (Label), a text box (Entry), and a Button control 

that exposes a Clicked event you can handle in C# code. The following simple example 

displays a message containing the text entered by the user. 
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Code Listing  3 

async void Handle_Clicked(object sender, System.EventArgs e) 
{ 
string message = $"You entered {this.InputBox.Text}"; 
await DisplayAlert("Information", message, "OK"); 
}  

It is worth mentioning that when you type the name of an event in the XAML code editor, Visual 
Studio will offer to generate a new C# event handler—simply press Tab to do so. At this point, 
the C# code editor will ask you to specify the position in the code for the new event handler, as 
shown in Figure 52. 

 

Figure 52: Adding a new C# event handler 

When Visual Studio adds a new event handler stub, the code simply throws a new 
NotImplementedException, and you will need to replace the default code with your own, like in 

the previous example. Writing XAML code to define the user interface is certainly intuitive, 
especially because the code editor provides a specialized version of the IntelliSense 
completion. However, it would be nice to have the option to preview the user interface while you 
code. Luckily enough, the XAML code editor in VS for Mac includes a feature called Preview, 
which you enable by clicking the same-named button located at the upper-right corner of each 
XAML editor tab. The previewer looks like the one shown in Figure 53, where it shows a preview 
of the result from the example XAML code. 
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Figure 53: Previewing the result of the XAML code 

You can decide to get a preview based on a phone or tablet, and you can also decide to get a 
preview based on iOS or Android. Figure 53 shows the preview based on the iOS renderer. 

 Tip: You will need to build the solution before you can use Preview for the first 
time. Also, if the renderer fails, it will show any error details so that you can fix your 
code and retry to see the preview. 

Debugging and testing Xamarin projects is really straightforward in Visual Studio for Mac. In the 
standard toolbar, you can select the platform you want to target by choosing the Android or iOS 
Project as the startup project, then you can pick one from the list of available devices, which 
includes emulators and physical devices (if connected to the Mac). Once you have selected the 
target platform and device, you can press Start on the standard toolbar to start debugging. 
Figure 54 shows how the sample application looks in both the iOS and Android emulators. 
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Figure 54: The sample app running inside the emulators 

You will be able to use all the debugging tools described in Chapter 3.  

 Tip: In order to test your apps on physical iOS devices, Visual Studio will need to 
invoke the Xcode SDK tools to generate certificates and provisioning profiles. More 
about these topics is available in the official Xamarin.iOS documentation.  

Xamarin project options 

Options for Xamarin projects can be deeply customized. For example, in the Xamarin.Forms 
solution created previously, in the Solution pad, right-click the name of the .NET Standard 
library project, then select Options. Only the Build tab will be discussed, in this section, as the 
other tabs have the same options and purposes you already saw for .NET Core projects. In the 
Build tab (see Figure 55), you can change the version of .NET Standard that the project 
supports. 

https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/device-provisioning/
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Figure 55: Build options for the .NET Standard project in Xamarin.Forms 

Now close the dialog and right-click the Android project name in the Solution pad, then select 
Options. You will find several tabs that are related to Android development, such as Android 
Build, Android Application and Android Package Signing. Within the first tab, you will find 
options to control the compilation process, and with the Android Package Signing, you will find 
options to sign the .apk generated package, which you require before publishing apps to Google 
Play. The options provided in these tabs will not be covered in detail here; additional comments 
are provided about the Android Application tab, which you can see in Figure 56. 
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Figure 56: The Android Application options 

Here you can specify an application-friendly name in the Application name box, as it will 
appear to your customers. You can also provide an icon and specify version numbers. The most 
important options are related to the version of the tools used for compilation and the Required 
permissions group. In the Minimum Android version combo box, you can specify the 
minimum Android version required to run your app. In the Target Android version combo box, 
you can specify the version of the Android SDK used to build the app. 

At the bottom, you will see a list of permissions that you must select if your app needs to access 
specific system functionalities. For example, you will need to select the Internet permission if 
your app needs to access the Internet. Remember that if you don’t specify the permissions the 
app needs, runtime exceptions will occur. 

Close the dialog, right-click the iOS project name in the Solution pad, and then select Options. 
In the iOS project options, there are the following tabs specific to iOS development: 

• iOS Build, which contains options that allow for controlling the build process. 
• iOS Debug, which contains options that allow for configuring the debugger port and WiFi 

debugging. 
• iOS On-Demand Resources, which contain options that allow for splitting the main app 

bundle into multiple chunks to reduce the app size. 
• iOS Bundle Signing, which is extremely important because it allows you to select the 

certificate that will be used for signing the app package (such as a development 
certificate or a distribution certificate) via the Signing Identity box, and it also allows you 
to select the provisioning profile based on the task you need to do (development or 
distribution). 

• iOS IPA Options, which allows you to customize properties of the generated .ipa (iOS 
App Store) app package. 
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Figure 57: The iOS Bundle Signing options 

Actually, for iOS projects, most of the app properties are set via the Info.plist (Information 
Property List) file, which you can see in the Solution pad, and for which Visual Studio for Mac 
provides a specific editor that appears once you double-click the file name. 

 

Figure 58: The Info.plist editor 
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The Identity group contains options that identify the app, like the application-friendly name, the 
bundle identifier (generated when you created the project), the version number, and the build 
number. The Signing group allows you to select the provisioning profile, and Visual Studio for 
Mac allows you to select between Manual Provisioning and Automatic Provisioning. With 
the latter, if you sign in with your Apple ID, Visual Studio for Mac will be able to generate all the 
certificates and all the profiles required to run your app on a physical device. If you click the 
Bundle Signing Options button, you will be redirected to the iOS Bundle Signing tab of the 
Options dialog, which you saw in Figure 57. 

In the Deployment group, you can specify options such as the minimum required version 
(Deployment Target), the device family (Universal, iPhone/iPod, or iPad), a startup screen 
(Main Interface), and the device orientation. You can optionally specify the status bar style, 
hide the status bar, and set the app to require full screen. 

Hints about publishing apps 

In order to publish apps you build with Visual Studio for Mac, you need paid developer accounts 
on the Google Play and the Apple Store. Then the IDE simplifies the whole process of 
publishing, assuming you performed all the preliminary steps required by both stores.  

For Android, you will need to specify all the required properties in the app manifest, and then 
you can select the Release or Ad-hoc configurations and run the Build > Archive for 
Publishing command. This command generates an .apk package that you will need to sign with 
keys you got in the Google Developer Console. Figure 59 shows an example of how Visual 
Studio makes it easy to generate an archive for publishing. 

 

Figure 59: Archiving a package for publishing 

https://developer.android.com/distribute/console/
https://developer.apple.com/programs/
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You will then be able to upload the signed .apk package to Google Play via the Developer 
Console. For iOS, things are a bit more complex. You will need to generate and download 
distribution certificates in the Apple Developer portal and associate them to your app via the 
Signing Identity options of the Info.plist editor (see Figure 58). You will also need to associate 
the bundle identifier of your app to the developer account. The IDE has integrated tools that 
simplify the deployment process but, due to the complexity of the preliminary steps needed, I 
recommend that you read the official documentation. 

Chapter summary 

Mobile app development is crucial to Microsoft, and Visual Studio for Mac offers everything you 
need to develop, build, and publish apps with powerful, integrated tools. Xamarin is the 
technology of choice that allows developers with a Microsoft background to write apps in C#. 
This chapter provided an overview of Xamarin and Xamarin.Forms, as well as the available 
project templates, and demonstrated how you can work with emulators to test your apps with 
hints about app publishing.  

Visual Studio for Mac also allows for integrated team collaboration, and the next chapter is 
about version control with Git. 
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Chapter 6  Version Control with Git 

Visual Studio for Mac supports team collaboration over source code by integrating with popular 
version control engines, such as Subversion and Git. Without a doubt, Git is the most used 
between the two, and for this reason I will use Git to demonstrate the collaboration capabilities 
of Visual Studio for Mac. Most of the features will also be available for Subversion. 

Preparing a sample repository 

Visual Studio for Mac can leverage all the most advanced Git features to work with source code, 
such as merging, branching, reviewing files, viewing differences and authors, and so on. To 
understand how it works, we first need to create a remote repository, and GitHub will be the 
service of choice. 

Log into GitHub with your account. If you don’t have one, you can register for free. Click New 
Repository and enter IncrementalHelloWorld for the project name, as shown in Figure 60. 

 

Figure 60: Creating a Git repository for a new project 

When you’re ready, click Create repository. Once the repository has been created, you will get 
to a page where you will see the new repository’s URL, which has the following form: 

https://github.com/YourAccount/IncrementalHelloWorld.git 

YourAccount stands for the user name you use on GitHub. Save this URL, since it will be used 
shortly. Now go back to Visual Studio for Mac and create a new .NET Core Console project 
called IncrementalHelloWorld, but do not enable Git version control, since the project will be 
associated to the remote repository created previously. The reason for this is that, at the 

https://github.com/
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moment, Visual Studio for Mac has limited support to publishing local repositories if they do not 
already have a matching remote repository.  

When the project is ready, right-click the solution name in the Solution pad, then select Version 
Control > Publish to Version Control. At this point, the Select Repository dialog appears. 
Here you need to specify the details of the remote repository, including the version control 
engine, which is Git in this case. Enter the repository URL and your account name, as shown in 
Figure 61. 

 

Figure 61: Entering a repository’s details 

The port number varies according to the protocol used. For example, with https, the port is 443. 
When you click OK, Visual Studio for Mac will ask for your confirmation to publish the project 
remotely and will request your GitHub (or any other Git service of your choice) credentials. After 
a few seconds, the project will be available both locally and remotely. 

Working with file changes 

In the Program.cs file, remove the blank space between the using directive and the 

namespace keyword, then add the following line right after the Console.WriteLine statement: 

Console.ReadLine(); 

With this line, you have introduced a change, and therefore, a difference between the local 
repository and the remote repository updated previously. At the bottom of the code editor, click 
the Changes tab. You will be able to compare the local files with the remote files. Lines of code 
highlighted in green represent new code, whereas lines of code underlined in red represent 
removed code. Figure 62 shows how the differences look. 
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Figure 62: Viewing file changes 

With the Authors tab (see Figure 63), you can see the authors of a specific piece of code, 
together with the commit details. If the code has not been committed yet, the author still appears 
in the view near the code that is currently a work in progress. 

 

Figure 63: Viewing code authors 
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With the Log tab, you can see the details of the edits made to each file in a commit. Look at 
Figure 64. In the box at the left side, you will see the list of commits. When more commits are 
available, you can click a commit and see its details on the right side of the tab. Additionally, 
when you select a commit, the area at the bottom of the tab shows the list of files that were 
committed and the edits they went through.  

 

Figure 64: Viewing commit logs 

The Merge tab is about merging branches and will be discussed later in this chapter. Now, 
suppose you want to commit the changes made previously. Select Version Control > Review 
Solution and Commit. As you can see in Figure 65, you will see the list of files with changes. 
In this case, the Program.cs file has a yellow icon, which means it has been edited, and a yellow 
overlay icon is also visible in the Solution pad for this file. New solution files are recognizable by 
a green overlay icon, whereas removed files are recognizable by a blue overlay icon. 

 

Figure 65: Reviewing file changes before commit 

www.dbooks.org

https://www.dbooks.org/


 

96 

If you expand the file, you will see a preview of the code changes, including new and removed 
code. Do not forget to enter a comment, and then click Commit. At this point, you will see the 
Commit Files dialog (see Figure 66). Here you can select the option to automatically push 
changes to the remote repository, so select the Push changes to remote repository after 
commit check box and click Commit. 

 

Figure 66: The Commit Files dialog 

 Note: If you get an error saying that the push operation could not be completed 
the first time you commit, it might be due to the fact that Visual Studio needs your Git 
credentials again. If this happens, select Version Control > Push Changes. Visual 
Studio will ask your Git credentials and will push any unsaved changes to the remote 
repository. Then commit again, and this time it should work. 

Once the code has been committed, the repository is up to date with the latest version of the 
code. If you opted for automatic pushing changes, the remote repository is also up to date. If 
you did not select this option, you can select Version Control > Push Changes. Remember to 
always push your changes when you want other developers to be able to work on the latest 
version of the source code. 

Collaborating with other developers 

Working with a version control service is not only important for keeping a history of the work on 
a project, but also because it simplifies the way a development team can collaborate on the 
same project. This section describes the available collaboration tools in Visual Studio for Mac 
that allow for Git integration. 

Cloning repositories 

When you want to work on a project that is associated to a version control service like Git, you 
need to get a copy of the source code, work on the code, and finally, you resubmit the code to 
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the server. In Git terminology, getting a copy of the source code is known as cloning a 
repository. 

In Visual Studio for Mac, you can clone a repository via Version Control > Checkout. When 
you do this, the Select Repository dialog appears (see Figure 67). Here you can specify the 
URL of the existing remote repository, your Git user account, and other properties like you did 
when pushing a local repository to its remote counterpart. 

 

Figure 67: Cloning a repository 

Click Checkout to start cloning the repository to the folder specified in the Target directory 
field. Obviously, you can select a different path. Once the repository has been cloned, you will 
be able to open the solution file as you would normally. 

Branching and merging 

Visual Studio for Mac has built-in support for creating and managing both local and remote 
branches. To work with branches, select Version Control > Manage Branches and Remotes. 
When the Git Repository Configuration dialog appears (see Figure 68), you will see a list of 
branches for the current project. In the sample project created previously, only the master 
branch is available. If you click New, you can create a new branch in the Branch Properties 
dialog, still visible in Figure 68. 
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Figure 68: Creating a branch 

Enter the branch name, then click OK. For the current example, I’m creating a branch called 
development. Alternatively, you can track an existing remote branch by using the Track a 
branch check box and selecting a branch from the drop-down list. The new branch will be 
visible in the Git Repository Configuration dialog. At this point, you can click Switch to 
branch to set the selected branch as the active branch. When you’re ready, click Close. Now 
that you have a new branch, replace the code of the Main method with the following, in order to 

introduce file changes. 

Code Listing  4 

        static void Main(string[] args) 
        { 
            Console.WriteLine("Type something:"); 
            string input = Console.ReadLine(); 
            Console.WriteLine(input); 
        }  

By following the lesson learned previously, review and commit your code. Figure 69 shows how 
file changes appear. 
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Figure 69: Reviewing changes on the new branch 

Click Commit when you’re ready and make sure your changes are pushed to the remote 
repository. Now switch to the master branch. As a shortcut, you can right-click the solution 
name in the Solution pad and select Switch to Branch > master. Now select Version Control 
> Merge Branch. When the dialog appears (see Figure 70), you can select the branch that will 
be merged into the current branch, development in this case. Let’s select development, then 
Merge. 
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Figure 70: Merging a branch 

The source code will be updated accordingly. When you’re satisfied with your changes, select 
Version Control > Push Changes so that the code will be updated to the remote branch as 
well. 

Resolving conflicts 

When merging branches, some conflicts can occur. In this case, you will be able to use the 
Merge tab of the code editor, where you will see the local version on the left side, the remote 
version on the right side, and a preview of how the code will appear at the center of the window. 
You will be able to resolve conflicts by selecting the parts of the code you want to include in the 
merging process. 

Synchronizing branches 

If more people are working on the same branch, it is important to stay up to date with the latest 
edits on the code. With Version Control > Update Solution, the current branch will be 
synchronized with the remote branch. 
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Hints about stashes 

Visual Studio for Mac also supports stashes. With stashes, Git allows for saving your edited files 
on a stack of unfinished changes that you can reapply at any time. This can be useful when you 
have not finished your work and you want to have a remote copy of your changes without 
affecting the repository with a commit. If you have experience with Team Foundation Server, 
now called Azure DevOps, this is similar to the Shelve operation. Stashes will not be discussed 
in this chapter, but Visual Studio for Mac provides the Stashes, Pop Stash, and Manage 
Stashes commands in the Version Control menu that help you work with this feature. 

Chapter summary 

More often than not, you need to collaborate over a project with other developers. Visual Studio 
for Mac has integrated support for the Subversion and Git version control services, but for Git, 
the integration is even more powerful. Once your project is under version control, you can easily 
see file changes and commit your work, so that other developers can then work on the project 
by first cloning the repository, and then creating and merging branches. All the work can be 
done inside Visual Studio, which offers convenient integrated tabs in the code editor and 
specific dialogs. So far, you have seen a large number of productivity features, but Visual Studio 
for Mac offers even more. In fact, it can be customized to better suit your preferences, and it can 
be extended so that its power is increased with third-party tools. 
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Chapter 7  Customizing and Extending 
Visual Studio for Mac 

A development environment is productive only if it is capable of making the developer feel at 
home, and Visual Studio for Mac certainly does. Being the powerful tool it is, it can be 
customized and extended in many ways, as you will learn in this chapter. 

Customizing Visual Studio for Mac 

Visual Studio for Mac can be customized in many ways in order to better fit with your 
preferences. Most of the customizations are available via the Preferences dialog, which you 
enable via Visual Studio > Preferences. Once the Preferences dialog pops up, you can walk 
through the available options. 

Applying a theme 

Themes in Visual Studio for Mac are of two types: the first type is about the language for the 
user interface, and the second type is about changing the colors of the user interface. Both are 
available in the Visual Style tab (see Figure 71). 

 

Figure 71: The Visual Style tab 
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Using the User Interface Language drop-down, you can select a different language. The 
default selection is called Default and makes Visual Studio use the same language as the 
language detected on your Mac. If the system language is not supported, English is then set as 
the default. With the User Interface Theme, you can select a visual theme between Light 
(default) and Dark. Figure 72 shows how Visual Studio for Mac looks with the Dark theme. 

 

Figure 72: The Dark theme 

Every time you select a theme, you will need to restart Visual Studio for Mac. 

Customizing author information 

The Author Information tab provides boxes that you can fill in with your personal information 
so that these will be automatically used in all projects to identify you as the developer. 

Customizing key bindings 

The Key Bindings tab (see Figure 73) allows for customizing keyboard shortcuts. You can 
customize by selecting a predefined scheme from the Scheme drop-down box and editing 
individual bindings. Available schemes are Visual Studio, Resharper/Rider, Visual Studio 
(Windows), Visual Studio (Mixed), Visual Studio Code, and Xcode, and you can also create 
custom schemes. 
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Figure 73: Editing key bindings 

You can then click an existing key binding and enter the key combination for the selected 
command in the Edit Binding text box. 

Customizing fonts 

You can customize the fonts used for the code editor, the General pad, and the Output pad. 
This can be easily accomplished via the Fonts tab (see Figure 74), where you can simply click 
the current font and change it to a different one (with different size and color) in the appearing 
font editor. 

 

Figure 74: Customizing fonts 

Customizing the color of comments 

When coding, it’s not unusual to add tokens like TODO, FIXME, and so on. In Visual Studio for 

Mac, you can make the code editor present these tokens in a different color. In the Tasks tab of 
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the Preferences dialog, you can specify the token and then select a color based on the token 
priority. You can also add custom tokens for a more customized experience.  

Custom tools 

Sometimes, you might need to invoke external tools from within the IDE. The External Tools 
tab allows for adding menu commands to invoke external tools, such as compilers, editors, and 
SDK applications. 

In Figure 75, you can see an example that shows how to add a new command that invokes the 
dotnet command line tool, passing the run parameter and the working directory. The latter can 

be specified as either a plain path or a constant that represents a specific directory. This 
example uses the ${TargetDir} constant that represents the directory where the result of the 

build process resides. 

 

Figure 75: Adding custom tools 

Notice how you can specify a key binding for the new command, and how you can decide to 
redirect the output of the external tool to the Output pad. When you click OK, the new command 
is added to the Tools menu. 

Introducing custom layouts 

You typically organize the layout of your workspace depending on the project type you are 
working on or on the task you are performing. For example, with Xamarin solutions, you might 
need to open and arrange some pads, while in ASP.NET Core projects, you might need other 
pads. Or, you might need the Debug pads when debugging an application, and need other pads 
when you’re finished debugging. 

To make things easier, Visual Studio for Mac has the concept of layout. The View menu 
provides some built-in layouts called Code, Design, Debug, and Test, and each layout is 
configured to show appropriate pads according to the current task, such as writing code, 
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designing the user interface, debugging, and testing code. You can quickly switch from one 
layout to another by clicking its name in the View menu. 

You can also create custom layouts that allow you to arrange the pads you need in the way you 
want, and to store the layout for later reuse. To accomplish this, you select View > Save 
Current Layout. In the dialog that appears, simply specify a custom name for your layout and 
click Create Layout. At this point, your new layout will be available in the View menu with built-
in layouts, and you will apply it by simply clicking its name. Visual Studio for Mac will also show 
a Delete command for your custom layouts. 

Extending Visual Studio for Mac 

Visual Studio for Mac can be extended with additional tools and components, such as new 
project templates, dialogs, tools that provide support for additional development platforms and 
services, and so on. You manage extensions via the Extension Manager dialog, which can be 
enabled via Visual Studio > Extensions. 

The Extension Manager tool consists of three tabs. The first tab (Installed) lists the installed 
extensions. You can expand each group and select individual extensions to see details, and you 
can also disable or uninstall extensions via the Disable and Uninstall buttons. The Updates 
tab lists extension updates, if any. The Gallery tab (see Figure 76) allows you to search for 
extensions on the Internet. 

 

Figure 76: Extending Visual Studio for Mac 
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You can select an extension to see its details on the right, then simply click Install to download 
it and install it to your Mac. 

Updating Visual Studio for Mac 

By default, Visual Studio for Mac will automatically search for new updates to the IDE, .NET 
Core, and Xamarin libraries. Updates will be downloaded, but not installed until you give 
permission to do so. You can also manually check for updates by selecting Visual Studio > 
Check for Updates. When you do this, the Visual Studio Update dialog will appear and will list 
available updates. You can also select the update channel in this dialog, such as Stable, Beta, 
and Alpha. Obviously, Beta and Alpha contain unstable software and should be avoided unless 
you want to get early access to the bits that cannot be used in production. 

 Tip: If you build apps for iOS with Xamarin, make sure that Visual Studio for Mac 
receives updates when new versions or updates of Apple Xcode are released. In fact, 
version matching between Apple SDKs and Xamarin is crucial for building apps 
without errors. 

Chapter summary 

Visual Studio for Mac can be customized and extended in many ways. You can change the 
language and theme of the user interface, change fonts and keyboard shortcuts, add custom 
commands, and save custom pad layouts for later reuse. You can also install extensions that 
provide further features and add support for new platforms and services. Visual Studio for Mac 
makes it easy to check for product updates, so that you’re always working with the most recent 
releases. 
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